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About this document

This Preside Multiservice Data Manager (MDM) document describes

• how to install the MDM software on a new MDM workstation

• how to perform basic configuration of the MDM software

• how to upgrade the MDM software

• how to remove the MDM software

The following topics are discussed in this section:

• “Who should read this document and why” (page 15)

• “What you need to know” (page 16)

• “How this document is organized” (page 16)

• “Text conventions” (page 17)

• “Related documents” (page 19)

Who should read this document and why
This document is intended for system and network administrators responsible 
for the installation and administration of the Preside Multiservice Data 
Manager (MDM) software.

For information that describes how to use the MDM applications, refer to 
241-6001-000 Preside MDM Documentation Guide which will direct you to 
the correct document.
Preside MDM Installation Guide   15.1RSUP
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What you need to know
You need to have had some exposure to both computers and network 
concepts. Basic computer literacy is required to operate a Preside 
Multiservice Data Manager (MDM) host; you need to know how to use a 
keyboard and a mouse, what a menu is, and how to start applications from a 
menu using a mouse.

The MDM software resides on a UNIX workstation. You should be familiar 
with a UNIX editting facility (vi, for example) so that you are able to modify 
files. You should be familiar with SUN workstations, the UNIX operating 
system, and network communications (IP, FTP, ATM, or frame relay).

Knowledge of network management concepts is required.

How this document is organized
This document contains the following sections:

• “Installing MDM software tasks” (page 21) describes the tasks required 
to install the Preside Multiservice Data Manager software on a new 
workstation.

• “Configuring network connectivity” (page 55) describes the network 
connectivity requirements for the Preside Multiservice Data Manager.

• “MDM workstation operating system” (page 29) provides installation 
information for the operating system required by the Preside 
Multiservice Data Manager software.

• “Device integration cartridge software” (page 33) describes how to 
obtain device integration cartridge software.

• “Installing MDM software” (page 35) describes how to install the 
Preside Multiservice Data Manager software.

• “MDM software patches” (page 51) describes how to install and remove 
Preside Multiservice Data Manager software patches.

• “Configuring a new MDM workstation” (page 65) describes how to 
configure a new Preside Multiservice Data Manager host.

• “Upgrading the MDM software” (page 95) describes how to install new 
Preside Multiservice Data Manager software on an existing Preside 
Multiservice Data Manager workstation.
241-6001-100   15.1RSUP   
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• “Administration Database schema migration” (page 99) describes how to 
migrate the Preside Multiservice Data Manager Administration Database 
schema to a newer version.

• “Uninstall MDM” (page 103) describes how to remove Preside 
Multiservice Data Manager software that was properly installed with the 
MDM Installer.

• “Recovering from an incomplete MDM software installation” (page 106) 
describes how to remove Preside Multiservice Data Manager (MDM) 
software that was only partially installed as a result of premature 
termination of the MDM Installer.

• “Installing X.25 software (DPN)” (page 117) describes how to install 
X.25 software.

• “Configuring an X.25 link (DPN)” (page 129) describes how to 
configure an X.25 link between the Preside Multiservice Data Manager 
workstation and a Data Packet Network (DPN) switch. 

• “Configuring an IP over X.25 link (DPN/Passport)” (page 141) describes 
how to configure an IP over X.25 connection between the Preside 
Multiservice Data Manager workstation and a Passport switch.

• “Installing frame relay software” (page 147) describes how to install and 
configure SunLink frame relay software.

• “Installing ATM software” (page 163) describes how to install and 
configure SunATM software.

• “HP OpenView Desktop” (page 173) describes how to install and 
configure the HP OpenView Desktop application.

.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.
Preside MDM Installation Guide   15.1RSUP
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• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

In Preside Multiservice Data Manager (MDM), uppercase and lowercase 
letters that appear in UNIX commands and parameters must be matched 
exactly. The system matches upper and lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default of ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).
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Related documents
This section identifies documents related to the Preside Multiservice Data 
Manager.

Preside Multiservice Data Manager
For a list of Preside Multiservice Data Manager documents, see 
241-6001-000 Preside MDM Documentation Guide.

Passport 6400
For a list of Passport 6000 documents, see 241-6401-001 Passport 6400 
Documentation Guide.

Passport 7400/15000/20000
For a list of Passport 7000/15000/20000 documents, see 241-5701-001 
Passport 7400, 15000, 20000 Documentation Guide.

Hewlett-Packard
If you are installing the HP OpenView Desktop (HP-OV) application, HP 
OpenView installation instructions can be obtained from the HP OpenView 
Network Node Manager Products Installation Guide.

Oracle
If you are installing a Preside Multiservice Data Manager Administration 
Database, Oracle database installation instructions can be obtained from the 
Oracle Administrators Reference for SUN SPARC Solaris, part number 
A85349-01.

Solaris
Solaris operating system installation instructions can be obtained from the 
Sun Microsystems Inc. Documentation Center at ‘www.sun.com/
documentation’.
Preside MDM Installation Guide   15.1RSUP
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Chapter 1
Installing MDM software tasks

This section describes the tasks required to install the Preside Multiservice 
Data Manager software on a new network management workstation.

To upgrade the MDM software to release 15.1 on an existing MDM network 
management workstation, see “Upgrading the MDM software” (page 95).

Navigation links
• “Installing MDM software task flow” (page 21)

• “Installing MDM software task navigation” (page 27)

Installing MDM software task flow
This task flow shows you the tasks you perform to install and initially 
configure software on a new Preside Multiservice Data Manager (MDM) 
workstation. To link to any task, go to “Installing MDM software task 
navigation” (page 27).
Preside MDM Installation Guide   15.1RSUP
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Installing MDM software task flow (Sheet 1 of 5)
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Installing MDM software task flow (Sheet 2 of 5)
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Installing MDM software task flow (Sheet 3 of 5)
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Installing MDM software task flow (Sheet 4 of 5)
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Installing MDM software task flow (Sheet 5 of 5)
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Installing MDM software task navigation
• “MDM workstation operating system” (page 29)

• “HP OpenView Desktop” (page 173)

• “Device integration cartridge software” (page 33)

• “Installing MDM software” (page 35)

• “MDM software patches” (page 51)

• “Configuring network connectivity” (page 55)

• “Configuring a new MDM workstation” (page 65)
Preside MDM Installation Guide   15.1RSUP
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Chapter 2
MDM workstation operating system

This section describes tasks related to the installation of the operating system 
on the Preside Multiservice Data Manager workstation.

Procedure navigation
• “Procedure prerequisites” (page 29)

• “Procedure steps” (page 29)

• “Job aids” (page 30)

Procedure prerequisites
• If the Solaris operating system is not installed on the Preside 

Multiservice Data Manager workstation, obtain the required software 
from Sun Microsystems Inc.

Procedure steps
1 Install the Solaris operating system according to the instructions provided 

by Sun Microsystems Inc.

Sun workstations can be delivered with the Solaris operating system 
software installed. If the operating system software is not installed, use 
the documentation provided by Sun Microsystems Inc. to install the 
software. If the documentation is not available or to ensure that the latest 
documentation was provided, go to the Sun Microsystems Documentation 
Center at ‘www.sun.com/documentation’.

Note:  Ensure that you install the correct ‘Solaris software group’. For 
more information, see 241-6001-102 Preside MDM Planning Guide.
Preside MDM Installation Guide   15.1RSUP
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2 Ensure that the Preside Multiservice Data Manager workstation disk 
space is partitioned according to the information in “Recommended disk 
partition sizes” (page 30) as a minimum specification.

3 Install all Solaris operating system patches as recommended by Sun 
Microsystems Inc.. See the Solaris Release Notes for a description of the 
required patches.

4 Optionally, enable the 'logging' mount option in the Solaris file system for 
UFS type file partitions. Logging reduces the time required to reboot the 
workstation by eliminating the need to run fsck on startup. As the userID 
root, edit the file /etc/vfstab and add logging to the mount options.

The default is no logging (i.e. a dash "-" in the mount options column).

See “Example of file /etc/vfstab with the logging option enabled” (page 31) 
for an example of the file /etc/vfstab with logging enabled.

Job aids

CAUTION
Solaris 8 can operate in 32 bit or 64 bit mode. On most 
Sun workstations the firmware for frame relay is not 
compatible with the 64-bit mode of operation. If you plan 
to operate Solaris 8 in 64-bit mode, Nortel Networks 
recommends that you use an external router as a frame 
relay access device (FRAD) to connect the Preside 
Multiservice Data Manager workstation to Passports in 
your network.

Table 1 
Recommended disk partition sizes

Partition Size

swap 3 * RAM

/var 1 Gbyte

/ (root) All disk space remaining after allocations for 
swap and /var.
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Table 2
Example of file /etc/vfstab with the logging option enabled

device to mount device to fsck mount 
point

FS 
type

fsck 
pass

mount 
at boot

mount 
options

/dev/dsk/c0t0d0s1 - - swap - no -

/dev/dsk/c0t0d0s0 /dev/rdsk/c0t0d0s0 / ufs 1 no logging

dev/dsk/c0t0d0s3 /dev/rdsk/c0t0d0s3 /var ufs 1 no logging

swap - /tmp tmpfs - yes -
Preside MDM Installation Guide   15.1RSUP
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Chapter 3
Device integration cartridge software

Obtain the device integration software cartridges for those SNMP devices 
supported by this Preside Multiservice Data Manager (MDM) workstation.

Note: This task is optional and is only required if the MDM Installer will 
be used to install device integration cartridges. The installation of device 
integration cartridges on an Preside Multiservice Data Manager 
workstation can be performed at any time without using the MDM 
Installer. This method of installation is described in 241-6003-100 
Preside Generic Device Integration Installation Guide.

Procedure navigation
• “Procedure prerequisites” (page 33)

• “Procedure steps” (page 34)

Procedure prerequisites
• install the “MDM workstation operating system” (page 29)

• purchase a Nortel Networks support plan and register for software 
download access

• although the task of obtaining device integration cartridges can be 
performed before the Preside Multiservice Data Manager software is 
installed, device integration cartridge software cannot be installed until 
the Preside Multiservice Data Manager software is installed and 
configured.
Preside MDM Installation Guide   15.1RSUP
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Procedure steps
1 As the userID root, from the UNIX command line, create a temporary 

directory.

For example, only:

mkdir /tmp/newcartridge

2 Record the new directory name. This directory name is required by the 
MDM Installer.

3 Download the cartridge from the Nortel Networks distribution site to the 
new directory. The URL is

http://www130.nortelnetworks.com/cgi-bin/eserv/cs/
main.jsp

4 Change directories to the new directory.

For example, only:

cd /tmp/newcartridge

5 Uncompress the file.

For example, only:

tar xvf 
MDM_Baystack_450_Cartridge_V1.0.0_Sun_b100.tar

A new subdirectory is created that contains the device integration 
cartridge software.
241-6001-100   15.1RSUP   
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Chapter 4
Installing MDM software

Install the Preside Multiservice Data Manager (MDM) software using the 
MDM Installer.

Navigation links
• “MDM software installation task flow” (page 35)

• “Task navigation” (page 37)

MDM software installation task flow
This taskflow shows you the sequence of procedures you perform to install 
the Preside Multiservice Data Manager (MDM) software. To link to any 
procedure, go to “Task navigation” (page 37).
Preside MDM Installation Guide   15.1RSUP
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MDM software installation task flow
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Task navigation
• “Installing MDM software (common)” (page 38)

• “Installing MDM software (silent mode)” (page 46)
Preside MDM Installation Guide   15.1RSUP
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Installing MDM software (common)
Install the Preside Multiservice Data Manager (MDM) software with all of 
the MDM Installer windows displayed or create an MDM Installer properties 
file without installing the Preside Multiservice Data Manager software. 

Procedure navigation
•  “Procedure prerequisites” (page 38)

• “Procedure steps” (page 38)

• “Job aids” (page 43)

Procedure prerequisites
• install the “MDM workstation operating system” (page 29).

• to support SNMP device integration, “Device integration cartridge 
software” (page 33)

Procedure steps
1 On the Preside Multiservice Data Manager workstation, as userID root, 

open a UNIX xterm.

2 If you are installing from a CD-ROM

Note:  Do not change directories (cd /cdrom/cdrom0) before executing the 
command install_mdm. Changing directories will cause problems when 
attempting to eject and load the CD-ROMs.

a. Insert the Preside Multiservice Data Manager compact disk labelled 
#1 into the CDROM driver, pattern side up. If your drive uses a disk 
caddy, insert the disk into the caddy pattern side up, then slide the 
disk caddy into the CD-ROM drive.

b. Launch the MDM Installer. Type

/cdrom/cdrom0/install_mdm [-p] [-h]

3 If you are installing from a disk, launch the MDM Installer from the 
directory that contains the MDM software. Type

<MDM_software_pathname>/install_mdm [-p] [-h]

4 You are prompted for a DISPLAY environment variable. The default is to 
use a console local to the Preside Multiservice Data Manager 
workstation.
241-6001-100   15.1RSUP   
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Enter the environment DISPLAY to launch the MDM 
Installer GUI [:0.0]

If your console is not local to the Preside Multiservice Data Manager 
workstation, enter the DISPLAY environment value (for example, 
BELTOR32:0.0).

5 The Nortel Networks splash screen opens, a countdown occurs, then the 
window closes.

6 The Introduction window opens.

The left panel of the window indicates the current phase of the installation. 
As selections are made, the indicator for each phase changes color. The 
contents of the right panel changes as each installation phase is 
presented.

Note:  The MDM Installer can be stopped at anytime before you press 
the Install button in step 21. Do not stop the software installation after the 
installation process has begun. 

You can easily remove the MDM software after successful completion 
(using “Uninstall MDM” (page 103)) and re-install the software.

To stop the MDM Installer, click Cancel.

7 Click Next.

8 The Preside Multiservice Data Manager License agreement window 
opens.

Review the license information. 

Click I accept the terms of the License Agreement, then click Next.

Another window opens requesting that you wait while the workstation is 
examined.

9 The System information window opens.

This window indicates

• the Solaris operating system (OS) currently installed on this 
workstation.

• the sizes of the disk partitions on this workstation and the disk 
partition sizes recommended for MDM software.

• Preside Multiservice Data Manager software (by release) currently 
installed on this workstation.
Preside MDM Installation Guide   15.1RSUP
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• Device integration software cartridges currently installed on this 
workstation.

• Preside Multiservice Data Manager licenses currently installed on 
this workstation.

If the actual sizes of the partitions are equal to, or larger than, the partition 
sizes recommended in 241-6001-102 Preside MDM Planning Guide, click 
Next.

If the suggested size for a partition is larger than the available partition 
size, re-partition the disk. Depending on the size of the disk drive on the 
workstation, you may also need to add another disk drive or replace the 
existing drive with a larger drive. Click Cancel to exit the MDM Installer 
and use the Sun documentation to re-partition the disk drive.

10 The MDM 15.1 install options window opens.

Select the software packages for this Preside Multiservice Data Manager 
workstation. For a list of the software packages, see “Preside Multiservice 
Data Manager software packages” (page 44).

Click Next.

11 The MDM 15.1 installation source path window opens.

If the indicated directory corresponds to the location of the software, click 
Next.

If you are installing from a directory other than the indicated directory, click 
Choose, select the appropriate folder, click Select; then click Next.

If the software packages are located in different directories, you are 
provided with prompts to select the appropriate directory for each 
package selected in step 10.

If the CD-ROM is available, the default source path is /cdrom/cdrom0. 
If the CD-ROM is unavailable, the default source path is the directory that 
contains the MDM Installer.

12 If one of the Preside Multiservice Data Manager software packages 
selected in step 10 was Multiservice Data Manager (MDM) or MDM 
Operator Client and User Administration and the domain name cannot be 
automatically determined, the window Enter domain name opens.

Type the domain name required to locate this workstation.

13 If you selected the option Management Data Provider (MDP) in step 10 
and this installation is not an Preside Multiservice Data Manager software 
upgrade, the MDP Administration userID window opens.
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The MDP user information window prompts for the MDP administrator 
userID.

Note:  If the MDP administrator userID was not created previously, create 
the userID now and then complete this step.

14 Click Next.

15 If you selected the option Multiservice Data Manager (MDM) in step 10, 
the Network Viewer background pixmaps window opens.

This window enables you to select optional bitmap images that can be 
installed and then used as the background for the Network Viewer. For 
example, you can use a map of the world as the background.

If you have decided to use the optional bitmap images, click Yes and 
proceed to the next step.

If you have decided not to use optional bitmap images, click No and 
proceed to step 17.

16 The Network Viewer background pixmap selection window opens.

Select the countries for which images should be installed.

17 If you selected Device Integration cartridges in step 10, the Device 
Integration cartridge selection window opens.

Select the Device Integration cartridges to install.

a. If the Preside Network Services Platform (NSP) is also installed on 
this MDM network management workstation, click NSP is co-
resident with MDM.

b. Enable the MDM Installer to update the Server Administration tool 
(SVMADM) with configuration information for the new device 
integration software.

In the data entry box Enter Server Administration password, type 
the current password for SVMADM access.

c. Click Next.

18 If you used the -p option to create an MDM Installer properties file, the 
Create installers.properties file window opens.

To save the file in a directory other than the current directory, click 
Choose, select the appropriate folder, click Select; then click Next.

Record the location of the file for future use.

19 If you used the -p option to create an MDM Installer properties file, the 
Properties file created window opens.
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To continue installing the Preside Multiservice Data Manager software, 
click Next.

If you are using the MDM Installer to create the properties file without 
installing the Preside Multiservice Data Manager software, click Cancel.

20 The Pre-installation summary window opens.

This summary indicates the software packages that will be installed and 
the space requirements for these packages.

If the software packages to be installed are incorrect, click Previous to 
return to the MDM 15.1 install options window and select the correct 
software packages.

If the amount of disk space required to install the indicated software 
exceeds the amount of available disk space, click Cancel to stop the 
installation.

21 Click Install.

The Installing MDM 15.1 window opens.

The MDM Installer displays the name of each Preside Multiservice Data 
Manager software package as it is installed. 

If you are installing from a CD-ROM, the MDM Installer prompts for 
additional CD-ROMs until all of the selected Preside Multiservice Data 
Manager software is installed.

22 After the installation of the Preside Multiservice Data Manager software is 
complete, if a valid 15.1 license key is not located on this workstation, the 
Enter new license window opens.

Type the new Preside Multiservice Data Manager software license in the 
provided data entry box.

Note:  If you do not enter an Preside Multiservice Data Manager software 
license key, a temporary software license is generated that is valid for all 
of the Preside Multiservice Data Manager software for a maximum of 30 
days. When you have a permanent Preside Multiservice Data Manager 
software license, manually apply the new license using the appropriate 
procedure in 241-6001-303 Preside MDM Administrator Guide.

23 Click Next.

24 If this is a new Preside Multiservice Data Manager software installation, 
the Launch QuickStart option window opens. 
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Preside Multiservice Data Manager QuickStart assists you to configure 
the MDM software to provide basic Passport and Nortel Networks 
Multiservice Provider Edge support.

If you select Yes, QuickStart is launched after the MDM Installer window 
closes.

If you select No, QuickStart is not launched after the MDM Installer 
window closes.

25 Click Next.

The Install complete window displays the installation summary.

Preside Multiservice Data Manager software installation is now complete.

26 Review the Preside Multiservice Data Manager software installation 
summary. If the summary indicates failure to install any of the Preside 
Multiservice Data Manager packages, examine the installation logs found 
in directory /opt/MagellanNMS/data/log/<release>_Install_logs and follow 
the instructions in “Recovering from an incomplete MDM software 
installation” (page 106). 

For more information about the installation logs, see “MDM software 
installation logs” (page 48).

27 Click Done.

The MDM Installer window closes.

If you selected Yes in step 24, proceed to section “Configuring a new 
MDM workstation” (page 65).

If you find it necessary to remove the MDM software for any reason, follow 
the instructions in “Uninstall MDM” (page 103).

Job aids
Table 3 
Variable definitions

Variable Definition

-p is used to create file 'installer.properties'. This file 
can then be used to clone this Preside 
Multiservice Data Manager software installation 
on other Preside Multiservice Data Manager 
workstations.
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The following table describes the Preside Multiservice Data Manager 
software packages.

-h displays this command usage information

MDM_software_
pathname

is the absolute pathname of the directory that 
contains the MDM Installer

Table 4
Preside Multiservice Data Manager software packages

Package Description

Multiservice Data 
Manager (MDM)

applications including fault, provisioning, and 
administration toolsets

MDM NTPs the online help sets used to provide context 
sensitive help and procedural information for 
Preside Multiservice Data Manager

MDM Operator Client and 
User Administration

the Preside Multiservice Data Manager Operator 
Client software and the software to administer 
Operator Clients. This package also includes 
software to create and administer users from a 
central location.

Management Data 
Provider (MDP)

a data collection application.

If Preside Multiservice Data Manager is not 
currently installed on this network management 
workstation, you must also select MDM.

MDP NTPs the online help sets used to provide context 
sensitive help and procedural information for 
MDP

 (Sheet 1 of 2)
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Variable definitions

Variable Definition
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The following table describes the Preside Multiservice Data Manager 
software installation logs.

HP OpenView Desktop 
client

a client for displaying fault information.

If Preside Multiservice Data Manager is not 
currently installed on this network management 
workstation, you must also select MDM.

Device Integration 
cartridges

fault management software for specific SNMP 
devices.

You cannot select MDM and Device Integration 
cartridges during the same MDM Installer 
session. 

Device integration cartridge software cannot be 
installed unless the Preside Multiservice Data 
Manager software is currently installed on this 
workstation.

Table 5
Preside Multiservice Data Manager software installation logs

Log Description

Install_summary.log This file contains a summary of the installation, 
indicating which package versions were added 
or replaced and which package installations 
succeeded or failed.

stopServers This file indicates Preside Multiservice Data 
Manager servers that were stopped during an 
MDM software upgrade. 

Package_logs This directory contains the detailed log files for 
each package installation or package removal. 
For example: install_MDM151Pbe, 
remove_MDM143Pac, install_MDMHELP.

Table 4
Preside Multiservice Data Manager software packages

Package Description

 (Sheet 2 of 2)
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Installing MDM software (silent mode)
Install the Preside Multiservice Data Manager (MDM) software without all of 
the MDM Installer windows displayed. 

Use the instructions in this section if you are familiar with Preside 
Multiservice Data Manager software installation and you have an MDM 
Installer properties file.

Procedure navigation
•  “Procedure prerequisites” (page 46)

• “Procedure steps” (page 46)

• “Job aids” (page 48)

Procedure prerequisites
• install the “MDM workstation operating system” (page 29).

• to support SNMP device integration, “Device integration cartridge 
software” (page 33)

• MDM Installer properties file

Procedure steps
1 On the Preside Multiservice Data Manager workstation, as userID root, 

open a UNIX xterm.

2 If you are installing from a CD-ROM

Note:  Do not change directories (cd /cdrom/cdrom0) before executing the 
command install_mdm. Changing directories will cause problems when 
attempting to eject and load the CD-ROMs.

a. Insert the Preside Multiservice Data Manager compact disk labelled 
#1 into the CDROM driver, pattern side up. If your drive uses a disk 
caddy, insert the disk into the caddy pattern side up, then slide the 
disk caddy into the CD-ROM drive.

b. Launch the MDM Installer. Type

/cdrom/cdrom0/install_mdm -g
-silent <install_pathname>/installer.properties 
[-h]
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3 If you are installing from a disk, launch the MDM Installer from the 
directory that contains the Preside Multiservice Data Manager software. 
Type

<MDM_software_pathname>/install_mdm 
-silent <install_pathname>/installer.properties 
[-g] [-h]

4 If you used the -g option, you are prompted for a DISPLAY environment 
variable. The default is to use a console local to the Preside Multiservice 
Data Manager workstation.

Enter the environment DISPLAY to launch the MDM 
Installer GUI [:0.0]

If your console is not local to the Preside Multiservice Data Manager 
workstation, enter the DISPLAY environment value (for example, 
BELTOR32:0.0).

5 If you used the -g option, the MDM Installer displays the name of each 
Preside Multiservice Data Manager package as it is installed and, if 
applicable, prompts for additional CD-ROMs.

6 The following message is displayed in the UNIX xterm.

Installation complete.

7 Review the Preside Multiservice Data Manager software installation 
summary. If the summary indicates failure to install any of the Preside 
Multiservice Data Manager packages, examine the installation logs found 
in directory /opt/MagellanNMS/data/log/<release>_Install_logs and follow 
the instructions in “Recovering from an incomplete MDM software 
installation” (page 106).

For more information about the installation logs, see “MDM software 
installation logs” (page 48).

8 To configure a new Preside Multiservice Data Manager workstation, use 
the instructions in section “Configuring a new MDM workstation” 
(page 65).

If you find it necessary to remove the MDM software for any reason, follow 
the instructions in “Uninstall MDM” (page 103).
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Job aids

The following table describes the Preside Multiservice Data Manager 
software installation logs.

Table 6 
Variable definitions

Variable Definition

-silent is used to install the MDM software without using 
the MDM Installer windows. Silent mode uses a 
properties file for the MDM installation and does 
not require user interaction. The properties file is 
created by running the MDM Installer with the '-p' 
option.

-g is used to install the MDM software in Silent 
mode but provides a popup window to prompt for 
CD-ROM disc changes. This option also 
provides a popup window that indicates 
installation progress. 

-h displays this command usage information

install_pathname is the absolute pathname of the directory that 
contains the MDM Installer properties file.

MDM_software_
pathname

is the absolute pathname of the directory that 
contains the MDM Installer

Table 7
MDM software installation logs

Log Description

Install_summary.log This file contains a summary of the installation, 
indicating which package versions were added 
or replaced and which package installations 
succeeded or failed.

 (Sheet 1 of 2)
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stopServers This file indicates MDM servers that were 
stopped during an MDM software upgrade. 

Package_logs This directory contains the detailed log files for 
each package installation or package removal. 
For example: install_MDM151Pbe, 
remove_MDM143Pac, install_MDMHELP.

Table 7 (Continued)
MDM software installation logs

Log Description

 (Sheet 2 of 2)
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Chapter 5
MDM software patches

This section describes how to apply and remove softwares patches for the 
Preside Multiservice Data Manager (MDM) software.

• “Installing an MDM software patch” (page 51)

• “Removing an MDM software patch” (page 54)

Installing an MDM software patch
This section describes how to apply a software patch for the Preside 
Multiservice Data Manager (MDM) software.

Normally, you are notified by your Nortel Networks customer respresentative 
when the latest MDM software patch for your MDM software release is 
available.

An MDM software patch includes all of the previous MDM software patches 
applicable to a software package in your MDM software release.

Procedure navigation
• “Procedure prerequisites” (page 51)

• “Procedure steps” (page 52)

• “Job aids” (page 53)

Procedure prerequisites
Perform this procedure when instructed by one of the following procedures:

• “Installing MDM software tasks” (page 21)
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• “Upgrading the MDM software” (page 95)

Procedure steps
1 Log in to the MDM network management workstation as userID root.

2 Transfer the MDM software patch tar file from the Nortel Networks 
Customer Support web site http://www130.nortelnetworks.com/cgi-bin/
eserv/cs/main.jsp to the directory /tmp.

3 Exit from all MDM applications.

4 If this is a data collection workstation that does not use Server 
Administration tool (SVMADM) to control the Management Data Provider 
(MDP) servers, type

/opt/MagellanMDP/bin/mdpadm stop all

5 Shutdown the MDM servers; type

/etc/init.d/nmssvm.server stop

6 Change directories to the directory /tmp.

cd /tmp

7 Unlink the individual MDM software patch.

zcat <release>-<patch>.tar.Z | 
tar -xvpf -

The files are placed in a new MDM software patch directory under 
directory /tmp. For example, /tmp/<release>-03.

8 Change directories to the MDM software patch directory.

cd <release>-<patch>

9 Run the Sun Microsystems Inc. patch installation utilitiy.

patchadd .

The MDM software files being replaced by the patches are backed-up to 
directory /var/sadm/pkg/<release>-<patch>.

The MDM software patch installs.

You are informed of a successful installation.

10 Perform the instructions in the file README. This file contains detailed 
instructions for activating the MDM software patches after installation.
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Job aids
Table 8
Variable definitions

Variable Definition

<release> the MDM software release number 
(for example, MDM142)

<patch> the patch version
(for example, 03)
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Removing an MDM software patch
This section describes how to remove an MDM software patch from the 
Preside Multiservice Data Manager (MDM) software.

1 Log in to the MDM workstation as userID root.

2 Run the Sun Microsystems Inc. patch removal utilitiy. Type

patchrm <release>-<patch>

The MDM software patch is removed.

You are informed of a successful patch removal.

3 Review the MDM Release Supplement for the current release or the 
README file included with the last installed MDM software patch. 
Determine the actions required to restore the MDM software to it’s 
previous state.
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Configuring network connectivity

This section identifies the tasks required to configure connectivity from a 
network device to the Preside Multiservice Data Manager (MDM) 
workstation. 

This section provides references to the documents required to perform the 
tasks. 

Navigation links
• “Network connectivity task flow” (page 55)

• “Task navigation” (page 57)

Network connectivity task flow
This task flow shows you the tasks you perform to connect a Nortel Networks 
network element to a Preside Multiservice Data Manager workstation. To link 
to any task, go to “Task navigation” (page 57).
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Network connectivity task flow

Configuring 
network 

connectivity

Select a 
connectivity 

method

X.25 link (DPN)

Read 
About 

communication 
links

IP over X.25 
(Passport)

IP over ethernet 
(Passport)

IP over frame 
relay (Passport)

IP over ATM 
(Passport)

IP connectivity 
(SNMP devices)

End
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Task navigation
• “About communications links” (page 58)

• “X.25 link (DPN)” (page 59)

• “IP over X.25 link (Passport)” (page 60)

• “IP over ethernet (Passport)” (page 61)

• “IP over frame relay (Passport)” (page 62)

• “IP over ATM (Passport)” (page 63)

• “IP connectivity (SNMP devices)” (page 64)
Preside MDM Installation Guide   15.1RSUP



58   Chapter 6 Configuring network connectivity
About communications links
To communicate with a Preside Multiservice Data Manager (MDM) 
workstation, you require the following:

• the hardware to establish a communications link to the workstation 
installed on the network element

• the service data for the communications link must be configured on the 
network element.

The type of communications link an MDM workstation uses for network 
access depends upon the composition of the network (see “Types of 
communications links” (page 58)). 

For more information about each network access type, see 241-6001-101 
Preside MDM Engineering Guide.

Table 9
Types of communications links

Network 
Composition

Switch type Link

DPN, only DPN X.25 link

mix of DPN and 
Passport

DPN X.25 link

Passport IP over X.25 link through DPN

Passport, only Passports 
configured 
as an ILS 
network

IP over ethernet or 
IP over frame relay

Passports 
not 
configured 
as an ILS 
network

 IP over frame relay

IP over ATM

SNMP devices IP over ethernet
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X.25 link (DPN)
Use the instructions in this procedure to configure an X.25 connection 
between a DPN switch and the Preside Multiservice Data Manager 
workstation.

For the instructions to provision the Network Control System (NCS), see 
241-2001-102 DPN-100 Network Control System User Guide.

For the instructions to provision LAPB X.25 service on a PE and PI, see 
241-1001-184 DPN-100 LAPB/X.25 Specification.

Procedure steps
1 Provision the Network Control System (NCS) on the DPN switches in the 

network.

2 Provision a Workstation Management Data Interface (WS-MDI) on an OA 
in the NCS.

3 Provision X.25 service on the DPN Processing Element (PE), Peripheral 
Interface (PI), and Port (PO) to which the MDM workstation is connected.

4 Follow the instructions in “Installing X.25 software (DPN)” (page 117).

5 Follow the instructions in “Configuring an X.25 link (DPN)” (page 129).
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IP over X.25 link (Passport)
Use the instructions in this procedure to configure an IP over X.25 connection 
between a Passport and the Preside Multiservice Data Manager (MDM) 
workstation using a DPN switch.

For the instructions to select a topology and provision the DPN, see 
241-7401-110 Passport 7400, DPN-100 Interworking Guide. 

For instructions to provision the Passport IPIVC, see 241-5701-270 Passport 
7400, 15000, 20000 Software Installation Guide.

Procedure steps
1 Configure the Passports to be managed as a Routing Identifier (RID) 

subnet that is managed through a Call Server Resource Module (CSRM) 
on a DPN switch.

2 Configure an IP Interface over Virtual Circuit (IPIVC) on each Passport 
that is managed by the MDM workstation.

3 Follow the instructions in “Configuring an IP over X.25 link (DPN/
Passport)” (page 141).
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IP over ethernet (Passport)
Use the instructions in this procedure to configure an ethernet connection 
between a Passport and the Preside Multiservice Data Manager workstation.

For the instructions to configure an inter-LAN switching (ILS) network and 
provision a virtual router, see 241-5701-270 Passport 7400, 15000, 20000 
Software Installation Guide.

Procedure steps
1 Configure the Passports to be managed as an inter-LAN switching (ILS) 

network.

2 Provision a virtual router with an IP port on the Passport providing 
network access for the MDM workstation.
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IP over frame relay (Passport)
Use the instructions in this procedure to configure a frame relay connection 
between a Passport and the Preside Multiservice Data Manager (MDM) 
workstation.

For the instructions to configure a FRUNI, see 241-5701-900 Passport 7400, 
15000, 20000 Frame Relay UNI Guide. 

For the instructions to configure IPIFRs, see 241-5701-270 Passport 7400, 
15000, 20000 Software Installation Guide.

Procedure navigation
• “Procedure prerequisites” (page 62)

• “Procedure steps” (page 62)

Procedure prerequisites
• If you have the Solaris 8 operating system configured in 64-bit mode on 

the MDM workstation, Nortel Networks recommends that you use an 
external router as a frame relay access device (FRAD) to connect to the 
Passport nodes in your network.

Procedure steps
1 Configure a Frame Relay User-to-Network Interface (FRUNI) on the 

Passport for each frame relay link from the MDM workstation.

2 Provision an IP Interface over Frame Relay (IPIFR) on each Passport that 
is managed by the MDM.

3 Follow the instructions in “Installing frame relay software” (page 147).
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IP over ATM (Passport)
Use the instructions in this procedure to configure an ATM connection 
between a Passport and the Preside Multiservice Data Manager (MDM) 
workstation.

For the instructions to configure an IP over ATM (ATM MPE) connection, see 
241-5701-810 Passport 7400, 15000, 20000 Configuring IP.

For the instructions to configure an IP over ATM connection, see 
241-5701-270 Passport 7400, 15000, 20000 Software Installation Guide.

Procedure steps
1 Configure an ATM Interface (ATMIF) on the Passport for each ATM link 

from the MDM workstation.

2 Provision an ATM Multi-Protocol Encapsulation (MPE) component on 
each Passport that is managed by the MDM.

3 Provision the static IP address of the ATM Network Interface Card (NIC) 
under the Virtual Router (VR) on the Passport.

4 Provision the logical IP address of the ATM port on the Passport under the 
VR on the Passport. The IP address of the Passport must be in the same 
subnet as the static IP of the ATM NIC.

5 Follow the instructions in “Installing ATM software” (page 163).
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IP connectivity (SNMP devices)
To manage SNMP devices, IP LAN or WAN connectivity must be provided 
on the Preside Multiservice Data Manager workstation and the SNMP 
devices.
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Configuring a new MDM workstation

Configure the Preside Multiservice Data Manager software on a new Preside 
Multiservice Data Manager workstation.

To upgrade the Preside Multiservice Data Manager software to release 15.1 
on an existing Preside Multiservice Data Manager workstation, see 
“Upgrading the MDM software” (page 95).

Navigation links
• “Configuration task flow” (page 65)

• “Task navigation” (page 68)

Configuration task flow
This taskflow shows you the sequence of procedures you perform to 
configure the Preside Multiservice Data Manager (MDM) software on a new 
Preside Multiservice Data Manager workstation. To link to any procedure, go 
to “Task navigation” (page 68).
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Configuration task flow (sheet 1 of 2)
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Configuration task flow(sheet 2 of 2)
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Task navigation
• “Launching the MDM configuration tool” (page 69)

• “Configuring access to an MDM Administration Database” (page 72)

• “Configuring the MDM fault surveillance software” (page 74)

• “Configuring the MDM configuration software” (page 78)

• “Configuring the data collection software” (page 80)

• “Configuring Passport access” (page 82)

• “Configuring MPE access” (page 86)

• “Activating the MDM software configuration” (page 90)

• “Configuring Netscape for the MDM online help system” (page 92)
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Launching the MDM configuration tool
This section describes how to

• launch the Preside Multiservice Data Manager configuration tool 
QuickStart

• register an Preside Multiservice Data Manager software license

• select the network devices to be supported on this Preside Multiservice 
Data Manager workstation

• select the Preside Multiservice Data Manager software components to be 
configured on this Preside Multiservice Data Manager workstation

Procedure navigation
• “Procedure prerequisites” (page 69)

• “Procedure steps” (page 69)

• “Job Aids” (page 71)

Procedure prerequisites
• perform “Installing MDM software” (page 35).

• review 241-6001-102 Preside MDM Planning Guide and identify how 
this Preside Multiservice Data Manager workstation fits into your 
network management architecture. Determine the following:

— the network devices supported on this workstation

— the Preside Multiservice Data Manager software components (fault, 
configuration, or data collection) to be configured on this 
workstation

• obtain a Preside Multiservice Data Manager software license key that 
permits the use of the selected Preside Multiservice Data Manager 
software components.

Procedure steps
1 If the MDM Installer was not used to launch QuickStart, using the userID 

root, do one of the following:

a. in a UNIX xterm, type

/opt/MagellanNMS/system/config/nms_QuickStart
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b. from the MDM Toolset

System->Administration->MDM Software QuickStart

2 If this workstation is already configured as a Preside Multiservice Data 
Manager workstation, you are prompted.

Are you sure you wish to continue?

If you do continue, QuickStart copies the Preside Multiservice Data 
Manager configuration files to the directory indicated on the current 
window. QuickStart then over-writes the configuration files.

3 If this workstation was not previously configured as a Preside 
Multiservice Data Manager workstation or if you elected to continue from 
the 
Warning - MDM Previously Configured window prompt, 
the QuickStart Introduction window opens.

QuickStart can be halted at any time during the configuration process by 
clicking the Cancel button.

If you are unsure of the information requested or provided in a previous 
window, use the Previous button to return to that window.

4 Click Next.

5 If a valid Preside Multiservice Data Manager software license exists on 
this workstation, the License window opens. This window displays the 
existing license information including the enabled options.

If a license does not exist, or is invalid, the License window opens without 
information about existing Preside Multiservice Data Manager software 
options. Type the new software license in the data entry box New license 
and click update.

Note:  If you do not enter a software license key, a temporary software 
license is generated for you. This temporary license is valid for all of the 
Preside Multiservice Data Manager software components for a maximum 
of 30 days. When you have a permanent software license, manually apply 
it to this software as described in 241-6001-303 Preside MDM 
Administrator Guide.

6 Click Next.

7 The MDM Component Selection window opens.

Use this window to select the network devices to be supported and the 
Preside Multiservice Data Manager software components to be 
configured on this workstation. The network devices and Preside 
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Multiservice Data Manager software components to select are listed in 
“Network devices and MDM software components” (page 71).

The default is that Passport and MPE devices are supported and all of the 
Preside Multiservice Data Manager applications are selected for 
configuration if an Preside Multiservice Data Manager software license 
exists on this workstation to support the selections. 

For example, if a software license for Data Collection (MDP) does not 
exist, the menu item for that Preside Multiservice Data Manager software 
component is greyed-out and cannot be selected for configuration on this 
workstation.

8 Click Next.

Return to the taskflow “Configuration task flow (sheet 1 of 2)” (page 66).

Job Aids
Table “Network devices and MDM software components” (page 71) 
describes the supported network devices and Preside Multiservice Data 
Manager software components.

Table 10
Network devices and MDM software components

Network device or MDM 
software component

Description

Passport network device (switch)
Nortel Networks 
Multiservice Provider 
Edge

network device (switch)

Fault applications to display alarms and to provide a 
network status of network devices and circuits

Configuration applications to configure network device 
components and services

Data Collection the Management Data Provider (MDP) application
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Configuring access to an MDM Administration Database
This section describes how to configure access to an Preside Multiservice 
Data Manager (MDM) Administration Database.

Note: This section is applicable to Preside Multiservice Data Manager 
workstations that support Passports. That is, if this workstation supports 
only Nortel Networks Multiservice Provider Edge, this section is not 
applicable to the configuration of this Preside Multiservice Data 
Manager workstation.

Procedure navigation
• “Procedure prerequisites” (page 72)

• “Procedure steps” (page 72)

Procedure prerequisites
• perform “Launching the MDM configuration tool” (page 69)

• install and prepare for use an Preside Multiservice Data Manager 
Administration Database. 
For more information about the Preside Multiservice Data Manager 
Administation Database, see 241-6001-400 Preside MDM 
Administration Database User Guide.

• Determine the following:

— the database name

— if the database is not installed on the local workstation, the hostname 
(or IP address) and the database access port number on the remote 
workstation

— the database access userID and password

Procedure steps
1 The Database window opens.

Click No database to indicate that a database is not required. This is the 
default.

Click Administration database to configure access to an Preside 
Multiservice Data Manager Administration Database.
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2 Click Next.

If you selected No database, return to the taskflow “Configuration task 
flow (sheet 1 of 2)” (page 66).

3 The Database Information window opens.

4 Add the database access information in the Database Access 
Information panel.

a. Type the database name, recognized by the database server, in the 
data entry box Database name.

b. Type the database hostname or host IP address in the data entry box 
Host name.

c. Type the database host access port number in the data entry box 
Port number.

The default port number is 1521.

d. Type the the database access userID in the data entry box User 
name.

e. Type the password for User name in the data entry box Password.

f. Re-type the password for User name in the data entry box Confirm 
Password.

5 Click Next.

Return to the taskflow “Configuration task flow (sheet 1 of 2)” (page 66).
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Configuring the MDM fault surveillance software
This section describes how to use QuickStart to configure the Preside 
Multiservice Data Manager (MDM) software for fault surveillance and 
performance monitoring of network devices and services.

Procedure navigation
• “Procedure prerequisites” (page 74)

• “Procedure steps” (page 75)

• “Job Aids” (page 77)

Procedure prerequisites
• perform “Launching the MDM configuration tool” (page 69)

• select Fault in the MDM Software Component window

• review 241-6001-102 Preside MDM Planning Guide and determine if 
this Preside Multiservice Data Manager workstation is a Standalone 
Fault workstation, a Standalone Fault with redundancy workstation, an 
Fault Alarm Aggregation workstation, or a Fault Client.

• if this Preside Multiservice Data Manager workstation supports 
Passports and this is a Standalone Fault , Standalone Fault with 
redundancy, or an Aggregated Fault workstation, perform “Configuring 
access to an MDM Administration Database” (page 72)

• if this is a Standalone Fault with redundancy workstation, identify the 
name of the remote Standalone Fault workstation from which alarms will 
be received and to which alarms will be sent.

• if this Preside Multiservice Data Manager workstation supports 
Passports and this is a Standalone Fault or Standalone Fault with 
redundancy workstation, identify the UTC offset used in the network

• if this is an Fault Alarm Aggregation workstation, identify the remote 
Preside Multiservice Data Manager workstations that will send alarms to 
this workstation

• if this Preside Multiservice Data Manager workstation is a Fault Client, 
determine the hostname (or IP address) of the associated Standalone 
Fault workstation
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Procedure steps
1 The Fault Type Selection window opens.

Use this window to select the type of fault surveillance workstation to 
configure. The types of Preside Multiservice Data Manager Fault 
workstations are listed in “Types of Preside Multiservice Data Manager 
Fault workstations” (page 77).

The default is Standalone Fault. 

2 Click Next.

If this Preside Multiservice Data Manager workstation supports Passports 
and you selected Standalone Fault or Standalone Fault with redundancy, 
proceed to step 3.

If this Preside Multiservice Data Manager workstation supports MPE, 
only, and you selected Standalone Fault or Standalone Fault with 
redundancy, return to the taskflow “Configuration task flow (sheet 1 of 2)” 
(page 66).

If you selected Fault Client, only, proceed to step 7.

If you selected Fault Alarm Aggregation, proceed to step 9.

3 The UTC Offset window opens.

Use this window to configure the Universal Time (UTC) offset. For more 
information about setting the UTC offset, see 241-6001-303 Preside 
MDM Administrator Guide.

To the prompt

Is the calculated value of Passport’s UTC offset 
correct?

If the UTC offset is correct, click Yes. This is the default.

To enter a different UTC offset, click No and type the new UTC offset 
using the data entry box to specify the offset hours and the pull-down box 
to specify east or west.

4 Click Next.

If you selected Standalone Fault, return to the taskflow “Configuration task 
flow (sheet 1 of 2)” (page 66).

If you selected Standalone Fault with redundancy, proceed to step 5.

5 The Fault Redundant window opens.
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In the data entry box Workstation name, type the name of the remote 
Standalone Fault with redundancy workstation from which alarms will be 
received and to which alarms will be sent .

6 Click Next.

Return to the taskflow “Configuration task flow (sheet 1 of 2)” (page 66).

7 The Fault Client window opens.

Type the name of the associated Standalone Fault workstation in the data 
entry box Workstation name.

8 Click Next.

Return to the taskflow “Configuration task flow (sheet 1 of 2)” (page 66).

9 The Fault Alarm Aggregation window opens.

Use this window to identify the Standalone Fault workstations that will 
send alarms to this Preside Multiservice Data Manager workstation.

10 To add to the list of Standalone Fault workstations

a. Type the name of the Standalone Fault workstation in the data entry 
box Workstation Name.

b. Click Add.

The Standalone Fault workstation’s name appears in the Workstation 
Name table.

11 To change a Workstation Name table entry

a. Click the table entry in the Workstation Name table.

b. Change the Standalone Fault workstation name in the data entry box 
Workstation Name.

c. Click Modify.

The changed Standalone Fault workstation name appears in the 
Workstation Name table.

12 To remove a Workstation Name table entry

a. Click the table entry in the Workstation Name table.

b. Click Delete.

The Workstation Name table entry is removed from the Workstation 
Name table.

13 Click Next.
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Return to the taskflow “Configuration task flow (sheet 1 of 2)” (page 66).

Job Aids
Table “Types of Preside Multiservice Data Manager Fault workstations” 
(page 77) describes the types of Preside Multiservice Data Manager fault 
workstations.

Table 11
Types of Preside Multiservice Data Manager Fault workstations

Type of MDM Fault 
workstation

Description

Standalone Fault This Preside Multiservice Data Manager 
workstation collects alarms from the network and 
provides tools to display and report faults.

Standalone Fault with 
redundancy

This Standalone Fault workstation also receives 
alarms from a remote Preside Multiservice Data 
Manager workstation and sends alarms to the 
remote Preside Multiservice Data Manager 
workstation.

Note:  The other Preside Multiservice Data 
Manager workstation in this redundant Preside 
Multiservice Data Manager workstation 
configuration must also be configured using 
QuickStart and using this option.

Fault Client, only This Preside Multiservice Data Manager 
workstation has the Preside Multiservice Data 
Manager fault surveillance tools configured but 
uses the fault information collected on an 
associated Standalone Fault workstation.

Fault Alarm Aggregation This Preside Multiservice Data Manager 
workstation collects alarms from Standalone Fault 
workstations.
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Configuring the MDM configuration software
This section describes how to use QuickStart to configure the Preside 
Multiservice Data Manager (MDM) software for configuration of network 
devices and services.

Procedure navigation
• “Procedure prerequisites” (page 78)

• “Procedure steps” (page 78)

Procedure prerequisites
• perform “Launching the MDM configuration tool” (page 69)

• select Configuration in the MDM Software Component window

• review 241-6001-102 Preside MDM Planning Guide and determine if 
this Preside Multiservice Data Manager workstation is a Standalone 
Configuration workstation or an Configuration Client.

• if this Preside Multiservice Data Manager workstation supports 
Passports and this is a Standalone Configuration workstation, perform 
“Configuring access to an MDM Administration Database” (page 72)

• if this Preside Multiservice Data Manager workstation is a Configuration 
Client, determine the hostname (or IP address) of the associated 
Standalone Configuration workstation

Procedure steps
1 The Configuration Type window opens.

Click Basic Configuration to configure this workstation as a Standalone 
Configuration Preside Multiservice Data Manager.

Click Configuration Client, only to configure this Configuration Client to 
use Preside Multiservice Data Manager configuration servers on another 
Preside Multiservice Data Manager workstation.

2 Click Next.

If you selected Basic Configuration, return to the taskflow “Configuration 
task flow (sheet 1 of 2)” (page 66).

3 The Configuration Client window opens.
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Type the name of the Standalone Configuration Preside Multiservice Data 
Manager workstation in the data entry box Workstation name.

4 Click Next.

Return to the taskflow “Configuration task flow (sheet 1 of 2)” (page 66).
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Configuring the data collection software
This section describes how to use QuickStart to configure the MDM 
Management Data Provider (MDP) software to collect spooled data.

Procedure navigation
• “Procedure prerequisites” (page 80)

• “Procedure steps” (page 80)

Procedure prerequisites
• perform “Launching the MDM configuration tool” (page 69)

• select Data Collection in the MDM Software Component window

• identify the MDP administrator userID and password

Procedure steps
1 The Spooled Data Collection (MDP) window opens.

Use this window to configure spooled data collection.

2 In the panel MDP Admin Unix account

a. select the userID of the MDP administrator from the pull-down box 
MDP Admin user ID.

The available name(s) were determined during MDM software 
installation. For more information, see “Installing MDM software” 
(page 35).

b. type the password for the MDP administrator userID in the data entry 
box Password.

The password is stored in an encrypted format.

c. re-type the password for the MDP administrator userID in the data 
entry box Confirm password.

3 If this Preside Multiservice Data Manager data collection workstation 
supports Passports, the panel Passport group for MDP is displayed. In 
this panel

a. type a name for the Passport group in the data entry box Group 
Name. The default Passport group name is MDP.

The Passports added in “Configuring Passport access” (page 82) are 
included in this group.
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b. type a Passport access userID in the data entry box User ID.

This userID must be configured on all of the Passports in the 
indicated Passport group.

c. type the password for the Passport access userID in the data entry 
box Password.

The password is stored in an encrypted format.

d. re-type the password for the Passport access userID in the data entry 
box Confirm password.

4 If this MDM data collection workstation supports MPE the panel 
MultiservIce Provider Edge group for MDP is displayed. In this panel

a. type a name for the MPE group in the data entry box Group Name. 
The default MPE group name is MDPMPE.

The MPEs added in “Configuring MPE access” (page 86) are 
included in this group.

b. type a MPE access userID in the data entry box User ID.

This userID must be configured on all of the MPEs in the indicated 
MPE group.

c. type the password for the MPE access userID in the data entry box 
Password.

The password is stored in an encrypted format.

d. re-type the password for the MPE access userID in the data entry box 
Confirm password.

5 The data collection software is configured to collect all datatypes from the 
network devices in the configured groups. Data collection begins at 00:00 
hours. For more information about scheduling data collection, see 
241-6001-309 Preside MDM Management Data Provider User Guide.

6 Click Next.

Return to the taskflow “Configuration task flow(sheet 2 of 2)” (page 67).
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Configuring Passport access
This section describes how to use QuickStart to configure the MDM software 
to access Passport switches.

Note: This section is applicable to Preside Multiservice Data Manager 
workstations that support Passport devices. That is, if this workstation 
supports only Nortel Networks Multiservice Provider Edge, this section 
is not applicable to the configuration of this Preside Multiservice Data 
Manager workstation.

Procedure navigation
• “Procedure prerequisites” (page 82)

• “Procedure steps” (page 82)

Procedure prerequisites
• perform “Launching the MDM configuration tool” (page 69)

• identify the Passport nodenames and IP addresses that this Preside 
Multiservice Data Manager workstation will support

• identify the Passport userID and password that this Preside Multiservice 
Data Manager workstation will require to access the supported Passports

Procedure steps
1 The Passport Access Data window opens.

This Passport network data is added to the Host Group Directory Server 
(HGDS) configuration file on the local Preside Multiservice Data Manager 
workstation.

For more information about the HGDS, see 241-6001-310 Preside MDM 
Server Reference Guide.

The HGDS can be updated after initial configuration using the Host Group 
Administration tool (hgadmin). For more information about this tool, see 
241-6001-303 Preside MDM Administrator Guide.

2 To import Passport access data from another Preside Multiservice Data 
Manager workstation, click Import from HGDS.cfg file.

The Import Passports window opens. Type
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• the name of the remote Preside Multiservice Data Manager 
workstation to retrieve Passport access data from in the data entry 
box Workstation Name.

• root in the data entry box Username.

• the password for the userID root in the data entry box Password.

a. Click OK.

The Import Passports window closes.

The table below the Passport access information panel is populated 
with the imported Passport entries.

3 In the panel Passport group names

• If this Preside Multiservice Data Manager workstation is being 
configured for Passport configuration and Passport fault surveillance, 
default Passport group names for Command access (PPALL) and 
Surveillance (SURV) are displayed.

• If this Preside Multiservice Data Manager workstation is being 
configured for Passport fault surveillance, only, default Passport 
group names for Command access (PPALL) and Surveillance 
(SURV) are displayed.

• If this Preside Multiservice Data Manager workstation is being 
configured for Passport configuration, only, the default Passport 
group name for Command access (PPALL) is displayed.

• If this Preside Multiservice Data Manager workstation is being 
configured for Passport spooled data collection (MDP), only, this 
panel is not displayed. The Passport group name defaults to the name 
configured in “Configuring the data collection software” (page 80).

If necessary, replace the Passport group name by double-clicking the 
Passport group name and typing a new name.

All of the Passport access information added or changed using this 
window is applied to all of the Passport groups in the Passport group 
names panel.

4 In the panel Passport group access

• If this MDM workstation is being configured for Passport spooled data 
collection (MDP), only, this panel is not displayed.

Note:  The information in this panel is mandatory.
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a. type the Passport access userID in the data entry box User ID.

This userID must be configured on all of the Passports within the 
Passport group.

b. type the password for the User ID in the data entry box Password.

The password is stored in an encrypted format.

c. re-type the password for the User ID in the data entry box Confirm 
password.

5 To add Passports to the Passport group(s), in the panel Passport access 
information

a. type the Passport nodename in the data entry box Node name.

b. type the IP address for the Node name in the data entry box IP 
address.

c. click Add.

The Node name and IP address appear in the table below the 
Passport access information panel.

6 To change a Passport entry

a. click the Passport entry in the table below the Passport access 
information panel.

The Node name and IP address appear in the data entry boxes.

b. to change the Passport nodename, re-type the Passport nodename 
in the data entry box Node name.

c. to change the IP address, re-type the IP address for the Node name 
in the data entry box IP address.

d. click Modify.

The changed Node name and IP address appear in the table below 
the Passport access information panel.

7 To remove a Passport entry from the Passport group(s)

a. click the Passport entry in the table below the Passport access 
information panel.

The Node name and IP address appear in the data entry boxes.

b. click Delete.

The Passport entry is removed from the table below the Passport 
access information panel.
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8 Click Next.

Return to the taskflow “Configuration task flow(sheet 2 of 2)” (page 67).
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Configuring MPE access
This section describes how to use QuickStart to configure the Preside 
Multiservice Data Manager software to access supported Nortel Networks 
Multiservice Provider Edge devices.

Note: This section is applicable to Preside Multiservice Data Manager 
workstations that support MPE devices. That is, if this workstation 
supports only Passports , this section is not applicable to the 
configuration of this Preside Multiservice Data Manager workstation.

Procedure navigation
• “Procedure prerequisites” (page 86)

• “Procedure steps” (page 86)

Procedure prerequisites
• perform “Launching the MDM configuration tool” (page 69)

• identify the Nortel Networks Multiservice Provider Edge nodenames and 
IP addresses that this Preside Multiservice Data Manager workstation 
will support

• identify the Nortel Networks Multiservice Provider Edge userID and 
password that this Preside Multiservice Data Manager workstation will 
require to access the supported MPE

Procedure steps
1 The Multiservice Provider Edge Access Data window opens.

This MPE network data is added to the Host Group Directory Server 
(HGDS) configuration file on the local Preside Multiservice Data Manager 
workstation.

For more information about the HGDS, see 241-6001-310 Preside MDM 
Server Reference Guide.

The HGDS can be updated after initial configuration using the Host Group 
Administration tool (hgadmin). For more information about this tool, see 
241-6001-303 Preside MDM Administrator Guide.

2 To import MPE access data from another Preside Multiservice Data 
Manager workstation, click Import from HGDS.cfg file.

The Import Multiservice Provider Edge window opens. Type
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• the name of the remote MDM workstation to retrieve MPE access 
data from in the data entry box Workstation Name.

• root in the data entry box Username.

• the password for the userID root in the data entry box Password.

a. Click OK.

The Import Multiservice Provider Edge window closes.

The table below the Multiservice Provider Edge access information 
panel is populated with the imported MPE entries.

3 In the panel Multiservice Provider Edge group names

• If this Preside Multiservice Data Manager workstation is being 
configured for MPE configuration and MPE fault surveillance, default 
MPE group names for Command access (MPEALL) and Surveillance 
(MPESURV) are displayed.

• If this Preside Multiservice Data Manager workstation is being 
configured for MPE fault surveillance, only, default MPE group names 
for Command access (MPEALL) and Surveillance (MPESURV) are 
displayed.

• If this Preside Multiservice Data Manager workstation is being 
configured for MPE configuration, only, the default MPE group name 
for Command access (MPEALL) is displayed.

• If this Preside Multiservice Data Manager workstation is being 
configured for MPE spooled data collection (MDP), only, this panel is 
not displayed. The MPE group name defaults to the name configured 
in “Configuring the data collection software” (page 80).

If necessary, replace the MPE group name by double-clicking the MPE 
group name and typing a new name.

All of the MPE access information added or changed using this window is 
applied to all of the MPE groups in the MPE group names panel.

4 In the panel Multiservice Provider Edge group access

• If this Preside Multiservice Data Manager workstation is being 
configured for MPE spooled data collection (MDP), only, this panel is 
not displayed.

Note:  The information in this panel is mandatory.
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a. type the MPE access userID in the data entry box User ID.

This userID must be configured on all of the MPEs within the MPE 
group.

b. type the password for the User ID in the data entry box Password.

The password is stored in an encrypted format.

c. re-type the password for the User ID in the data entry box Confirm 
password.

5 To add MPE to the MPE group(s), in the panel Multiservice Provider 
Edge access information

a. type the MPE nodename in the data entry box Node name.

b. type the IP address for the Node name in the data entry box IP 
address.

c. click Add.

The Node name and IP address appear in the table below the MPE 
access information panel.

6 To change a MPE entry

a. click the MPE entry in the table below the MPE access information 
panel.

The Node name and IP address appear in the data entry boxes.

b. to change the MPE nodename, re-type the MPE nodename in the 
data entry box Node name.

c. to change the IP address, re-type the IP address for the Node name 
in the data entry box IP address.

d. click Modify.

The changed Node name and IP address appear in the table below 
the MPE access information panel.

7 To remove a MPE entry from the MPE group(s)

a. click the MPE entry in the table below the MPE access information 
panel.

The Node name and IP address appear in the data entry boxes.

b. click Delete.

The MPE entry is removed from the table below the MPE access 
information panel.
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8 Click Next.

Return to the taskflow “Configuration task flow(sheet 2 of 2)” (page 67).
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Activating the MDM software configuration
This section describes how to use QuickStart to activate the Preside 
Multiservice Data Manager (MDM) software configuration.

Procedure navigation
• “Procedure prerequisites” (page 90)

• “Procedure steps” (page 90)

Procedure prerequisites
• perform “Launching the MDM configuration tool” (page 69)

• perform one, or more, of

— “Configuring access to an MDM Administration Database” 
(page 72)

— “Configuring the MDM configuration software” (page 78)

— “Configuring the MDM fault surveillance software” (page 74)

— “Configuring the data collection software” (page 80)

— “Configuring Passport access” (page 82)

— “Configuring MPE access” (page 86)

Procedure steps
1 The Summary window opens.

This window displays the Preside Multiservice Data Manager software 
information collected during this QuickStart session. Displayed are 
reminders about Preside Multiservice Data Manager configuration, such 
as:

• for Fault Client workstations, configure the associated Standalone 
Fault workstation

• for Configuration Client workstations, configure the associated 
Standalone Configuration worksation

• for Standalone Fault with redundancy workstations, configure the 
remote Standalone Fault with redundancy workstation

• the shared memory is set to 256 Mbytes. If this is not sufficient, use 
the instructions in 241-6001-303 Preside MDM Administrator Guide 
to change the setting
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Confirm that the information in the Summary window is correct.

If the information is correct, click Configure.

If the information is not correct, click Previous until the appropriate 
QuickStart window is displayed. Make the necessary configuration 
changes.

2 The Configuration Complete window opens. This window indicates:

• successful configuration of this Preside Multiservice Data Manager 
workstation

• updated configuration files

3 To the prompt

Reboot the workstation immediately after exiting MDM 
QuickStart?

If you are ready to begin using this Preside Multiservice Data Manager 
workstation, click Yes.

If you need to delay using this Preside Multiservice Data Manager 
workstation, click No.

4 Click Done.

The QuickStart wizard window closes.

The local Preside Multiservice Data Manager servers are launched after 
this workstation is restarted. For more information about the Preside 
Multiservice Data Manager servers, see 241-6001-310 Preside MDM 
Server Reference Guide.

A log of the QuickStart session is written to the file
/opt/MagellanNMS/data/quickstart/Quickstart.log.
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Configuring Netscape for the MDM online help system
This section describes how to ensure that the Netscape application installed 
on this workstation can be used by the Preside Multiservice Data Manager 
(MDM) online help system.

Procedure navigation
• “Procedure prerequisites” (page 90)

• “Procedure steps” (page 90)

• “Job aids” (page 93)

Procedure prerequisites
• install the “MDM workstation operating system” (page 29)

Procedure steps
1 Determine the version of Netscape currently installed on this workstation. 

As the userID root, type

/usr/dt/appconfig/netscape/netscape -version

Compare the result to the recommended version of Netscape in the 
Preside Multiservice Data Manager Release Supplement document.

2 If the version of Netscape currently installed on this workstation is 
compatible with the recommended version in the Preside Multiservice 
Data Manager Release Supplement, this task is complete.

If the version of Netscape currently installed on this workstation is not 
compatible with the recommended version in the Preside Multiservice 
Data Manager Release Supplement, continue with this procedure.

3 Install the Netscape application in directory /usr/dt/appconfig/netscape.

If you install the Netscape application in directory /usr/dt/appconfig/
netscape, this task is complete.

If you cannot install the Netscape application in directory /usr/dt/
appconfig/netscape, continue with this procedure.

4 Install the Netscape application in any directory.

5 Perform one of the following steps:

a. Create a softlink to the installed Netscape application. As the userID 
root, type
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ln -s <netscape> /usr/dt/appconfig/netscape/
netscape

b. Edit the Preside Multiservice Data Manager configuration file 
/opt/MagellanNMS/bin/nmscsh and replace the line

#setenv NMSWEBBROWSER

with

setenv NMSWEBBROWSER <netscape>

6 This task is complete.

Job aids
Table 12 
Variable definitions

Variable Definition

<netscape> The absolute pathname for the installed 
Netscape application.
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Chapter 8
Upgrading the MDM software

This section describes how to upgrade the Preside Multiservice Data Manager 
(MDM) software on a Preside Multiservice Data Manager workstation.

Note: Nortel Networks does not support the rolling-back of the Preside 
Multiservice Data Manager (MDM) software. To return to a previous 
version, we suggest that you first remove the current version of the MDM 
software (see “Uninstall MDM” (page 103)) before re-installing a 
previous version (see “Installing MDM software” (page 35)).

Procedure navigation
• “Procedure prerequisites” (page 95)

• “Procedure steps” (page 96)

• “Job aids” (page 97)

Procedure prerequisites
• Review the MDM Release Supplement document and note:

— the MDM Platform and Software Level Compatibility section

— the MDM Software Installation Procedure for the supported 
migration restrictions

— the General Release Considerations

— the availability of software patches for this release of the MDM 
software
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• Contact your Nortel Networks Customer Representative to determine the 
availability of software patches applicable to this MDM software release. 

• If this workstation is part of one of the following network management 
architectures, ensure that an alternate MDM server workstation is 
performing the tasks of this workstation

— redundant fault management

— redundant fault management with aggregation

— client-server configuration

Procedure steps
1 Log in to the MDM workstation as userID root.

2 Increase available disk space by removing obsolete software and data 
files. For some examples of disk space savings, see “Examples of disk 
space savings” (page 97).

3 Shutdown all of the MDM servers; type

/etc/init.d/nmssvm.server stop

4 Follow the instructions in section “Shutting-down MDM” (page 113).

5 Follow the instructions in section “Backing-up MDM information” 
(page 115).

6 If the MDM Release Supplement indicates a requirement to upgrade the 
Solaris operating system or to apply Solaris operating system patches, do 
this now. For more information, see “MDM workstation operating system” 
(page 29).

7 Install the new MDM software. Follow the instructions in section “Installing 
MDM software” (page 35).

Note:  Before the MDM Installer window closes, you are instructed to 
restart the network management workstation. Postpone the workstation 
restart until later in this upgrade process.

CAUTION
Do not remove software or data until you have verified 
that the software or data is not essential to current or future 
functional requirements.
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8 If software patches are required, follow the instructions in section 
“Installing an MDM software patch” (page 51).

9 Follow the instructions in section “Restarting MDM” (page 114).

10 If this MDM workstation is configured with the MDM Administration 
Database and

a. if it is necessary to upgrade the version of Oracle software used by 
the MDM Administration Database, do this now.

b. if the MDM Release Supplement indicates a requirement to upgrade 
the MDM Administration Database schema, see “Administration 
Database schema migration” (page 99).

11 If free disk space is insufficient and testing of the new release and 
subsequent software patches is complete, remove the backed-up 
software files created by the installation of software patches in step 8.

12 To increase the amount of free disk space, remove the previous release 
of the MDM software. Follow the instructions in section “Uninstall MDM” 
(page 103).

Note:  Do not remove the previous release of the MDM software until 
thorough testing of the new MDM software is complete.

Job aids
Table 13
Examples of disk space savings

Description Location
old versions of Preside 
Multiservice Data 
Manager software

Note:  Do not remove the 
current version of the 
Preside Multiservice Data 
Manager software. It may 
be necessary to rollback 
the software after the 
upgrade.

/opt/MagellanNMS/loads/<software_loadname>/

old Passport data models /opt/MagellanNMS/cfg/PassportSchema/
old Network Models /opt/MagellanNMS/data/model/nmf/
RTAC alarm files /opt/MagellanNMS/data/rtac/data
old backup data /opt/MagellanNMS/data/Backup_Data
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Chapter 9
Administration Database schema migration

This section describes how to migrate the Preside Multiservice Data Manager 
(MDM) Administration Database schema to the latest version.

Procedure navigation
• “Procedure prerequisites” (page 99)

• “Procedure steps” (page 99)

• “Job aids” (page 102)

Procedure prerequisites
• Export the Preside Multiservice Data Manager Administration Database 

contents to a secure location.

Procedure steps
1 If you are migrating the database schema from an Preside Multiservice 

Data Manager software version greater than R14.2, proceed to step 12.

CAUTION
Nortel Networks recommends that you backup the 
contents of your MDM Administration Database before 
continuing with this procedure. After performing this 
procedure, if it is necessary to rollback to the previous 
release of Preside Multiservice Data Manager software, 
you will need to restore the database contents and 
resynchronize your database.
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2 If the destination database user is in the same database instance as the 
source database user and the destination database user is accessed by 
the public synonyms, remove the previous synonyms. In the Oracle 
SQL*Plus interface as the database administrator SYSTEM, type

SQL> @/opt/MagellanNMS/lib/sql/admindb/oracle/
drop_141_syns.sql

3 If the default customer does not own the majority of the database entities, 
it may be necessary to create a new customer and configure this new 
customer as the default customer. For more information, see 
241-6001-400 Preside MDM Administration Database User Guide.

4 Create a new database user. For more information, see 241-6001-400 
Preside MDM Administration Database User Guide

Note:  Do not attempt to populate the new database.

5 Connect to the database as the DBA user SYSTEM and grant CREATE 
PROCEDURE privilege to the new user created in step 4.

6 If the old database exists on a workstation other than the workstation 
where the new database resides, edit file $ORACLE_HOME/network/
admin/tnsnames.ora to locate the old database from the new database 
workstation.

7 Connect to the database as the new database user.

$ORACLE_HOME/bin/sqlplus <new_user_name>/
<new_user_password>@database 

8 Create a database link to the previous database user. In the Oracle 
SQL*Plus interface, type

SQL> CREATE DATABASE LINK <db_link_name> CONNECT TO 
<old_user_name> IDENTIFIED BY <old_user_password> 
USING '<old_database>'

9 Create the migration package. In the Oracle SQL*Plus interface, type

SQL> @/opt/MagellanNMS/lib/sql/admindb/oracle/
migrate_143.pkg

10 Execute the database migration process. In the Oracle SQL*Plus 
interface, type

SQL> @/opt/MagellanNMS/lib/sql/admindb/oracle/
runMigration <db_link_name>

The existing data is propogated to the new database instance and 
formatted using the new database schema.
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11 Remove the migration package. In the Oracle SQL*Plus interface, type

SQL> drop package migrate_143;

12 Migrate the database schema. In the Oracle SQL*Plus interface, type

SQL> @/opt/MagellanNMS/lib/sql/admindb/oracle/
migrate_143_151

13 Create the new load mapping. In the Oracle SQL*Plus interface, type

SQL> @/opt/MagellanNMS/lib/sql/admindb/
admin_cdl_mappings.sql

14 Enable database access. Edit the file /opt/MagellanNMS/cfg/dba/
dbaccess.cfg and set the parameter databases to the new database 
instance and set the parameter admindb.disabled to false.

15 Disable circuit and IP VPN discovery.

a. Using the Server Administration tool, select Data Sync Server.

b. Right click to select Edit Configuration -> Server Configuration.

c. Expand the Embedded Servers selection.

d. Select DBSyncController.

e. In the arguments field, add -noDiscovery.

f. Select File -> Save to save your changes.

g. Restart the Data Sync Server.

16 Using the Data Synchronization Administration tool, monitor the loading 
status for all of the devices.

The network configuration data has completed loading when the loading 
status of all devices indicates LOADED.

Note:  Do not proceed until the network configuration data has completed 
loading.

17 Stop the Database Synchronization Server (DATASYNCSERVER) using 
the MDM Server Administration tool.

18 Enable circuit and IP VPN discovery.

a. Using the Server Administration tool, select Data Sync Server.

b. Right click to select Edit Configuration -> Server Configuration.

c. Expand the Embedded Servers selection.

d. Select DBSyncController.
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e. In the arguments field, remove -noDiscovery.

f. Select File -> Save to save your changes.

19 Restart the Database Synchronization Server (DATASYNCSERVER) 
using the Server Administration tool.

Discovery is complete when all of the nodes in the ADMIN_NODE_VIEW 
table indicate SUCCESS in the DISCOVERY_STATUS column.

Job aids
Table 14
Variable definitions

Variable Definition

<db_link_name> name of user’s link to the database

<old_user_name> previous database user name

<old_user_password> password for previous database user name

<old_database> name configured in the file tnsnames.ora for the 
previous database instance

<new_user_name> new database user name

<new_user_password> password for new database user name
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Chapter 10
MDM software removal

Use the information in this section to remove Preside Multiservice Data 
Manager (MDM) software that was installed with the MDM Installer.

Navigation links
• “Uninstall MDM” (page 103)

• “Recovering from an incomplete MDM software installation” (page 106)

Uninstall MDM
This section describes how to remove Preside Multiservice Data Manager 
(MDM) software that was properly installed with the MDM Installer.

Procedure navigation
• “Procedure prerequisites” (page 103)

• “Procedure steps” (page 103)

• “Job aids” (page 104)

Procedure prerequisites
• Perform the steps in procedure “Removing an MDM software patch” 

(page 54) to remove software patch files before using this procedure.

Procedure steps
1 Log in to the Preside Multiservice Data Manager workstation as userID 

root.
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2 Change directories to the directory that contains the Preside Multiservice 
Data Manager uninstall tool for the Preside Multiservice Data Manager 
software release to be removed.

cd /opt/MDM<release>_INST

3 Start the Preside Multiservice Data Manager software removal tool 
InstallAnywhere Uninstaller. Type

./uninstall_mdm[134 or 141] (for release 13.4 or 14.1)

./uninstall_mdm (for any release above 14.1)

The InstallAnywhere Uninstaller window opens. 

4 Select Uninstall.

A window that indicates the packages available for uninstallation opens. 
Select the packages to uninstall and click Uninstall Selected Packages.

A progress bar indicates the stage of removal for each package.

A popup window indicates completion. Click Ok.

The Uninstaller logs are located in the directory /opt/MagellanNMS/data/
<release>_Install_logs. For more information about uninstaller logs, see 
“MDM software uninstall logs” (page 105).

5 Select Done.

6 You have completed this procedure.

Job aids

The following table describes the MDM software uninstall logs.

Table 15
Variable definitions

Variable Definition

<release> the MDM software release number 
(for example, 142)
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Table 16
MDM software uninstall logs

Variable Definition

stopServers This file indicates MDM servers that were 
stopped during an MDM software upgrade. 

Package_logs This directory contains the detailed log files for 
each package uninstall. For example: 
uninstall_MDM143Pac, uninstall_MDMHELP.

Uninstall_summary.log This file contains a summary of the software 
uninstall, indicating which package versions 
were uninstalled and which package uninstalls 
succeeded or failed.
Preside MDM Installation Guide   15.1RSUP



106   Chapter 10 MDM software removal
Recovering from an incomplete MDM software installation
This section describes how to remove Preside Multiservice Data Manager 
(MDM) software that was only partially installed as a result of premature 
termination of the MDM Installer.

Procedure steps
1 Log in to the MDM workstation as userID root.

2 Open the file
/opt/MagellanNMS/data/log/<release>_Install_logs/Install_summary.log.

3 Identify the last MDM software package to have been partially or 
completely installed. Find the last occurance of the following statement:

Starting Installation of <package>

4 Perform the remaining steps in this procedure for each of the MDM 
software packages installed, or having attempted to install, in the last 
installation session. Begin with the software package identified in step 3 
and proceed upwards in the log file towards the last occurance of the 
following statement:

Starting new installer session for:

5 If the log messages for the software package includes the following 
statement, ignore this software package and proceed to the previous 
software package:

This package will not be re-installed.

6 If the log messages for the software package includes the following 
statement, perform the remaining steps in this procedure.

Adding package ...

7 Confirm the installation of the software package. Type

/bin/pkginfo <package>

If the result of this command is the following:

ERROR: information for "<package>" was not found

proceed to the previous software package in the log file.

If the result of this command is the following:

application <package> <package description>

perform the remaining steps in this procedure.
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8 Remove the software package. Type

/bin/pkgrm <package>

9 Respond to the subsequent Solaris software package removal command 
prompts.

If the software package cannot be successfully removed, contact Nortel 
Networks support.

10 Return to step 5 until all of the software packages identified in the last 
installation session of the log file have been addressed.

11 You have completed this procedure.

Re-install the MDM software using the MDM Installer.

Job aids
Table 17
Variable definitions

Variable Definition

<release> the MDM software release number 
(for example, 151)

<package> the name of an MDM software package
(for example, NNlogbwsr)
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Chapter 11
Managing MDM software

This section describes how to manage the Preside Multiservice Data Manager 
(MDM) software.

Navigation links
• “Shutting-down MDM” (page 113)

• “Restarting MDM” (page 114)

• “Backing-up MDM information” (page 115)

• “Restoring MDM information” (page 116)
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 MDM software management task flows
These taskflows show you the sequence of procedures you perform to manage 
the Preside Multiservice Data Manager (MDM) software. To link to any 
procedure, go to “Navigation links” (page 109).

The following taskflows include

• “Backing-up MDM information task flow” (page 111)

• “Restoring MDM information task flow” (page 112)
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Backing-up MDM information task flow

Backing-up
 MDM

Shutting-down 
MDM

Backing-up MDM 
information

Restarting MDM

End
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Restoring MDM information task flow

Restoring 
MDM

Shutting-down 
MDM

Restoring MDM 
information

End

Restarting MDM
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Shutting-down MDM
This section describes how to shutdown the Preside Multiservice Data 
Manager (MDM) workstation.

Procedure prerequisites
• If this workstation is part of one of the following network management 

architectures, ensure that an alternate Preside Multiservice Data Manager 
server workstation is performing the tasks of this workstation

— redundant fault management

— redundant fault management with aggregation

— client-server configuration

Procedure steps
1 Log in to the MDM workstation as userID root.

2 Record the current state of the MDM servers. Type

svmcmd -list > /opt/MagellanNMS/serverList

A list of the MDM servers configured on this workstation is recorded in file 
/opt/MagellanNMS/serverList.

3 Exit from all MDM applications.

4 Shutdown all of the MDM servers; type

/etc/init.d/nmssvm.server stop

5 If this MDM workstation is configured with the MDM Administration 
Database, disable access to the MDM Administration Database. 
Edit the file /opt/MagellanNMS/cfg/dba/dbaccess.cfg and set the 
parameter admindb.disabled to true.
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Restarting MDM
This section describes how to restart the Preside Multiservice Data Manager 
(MDM) workstation.

Procedure steps
1 Log in to the MDM workstation as userID root.

2 Reboot the MDM workstation; type

init 6

3 Ensure that the required MDM servers are running.

a. Start the MDM Toolset.

b. From the MDM main menu, select 
System -> Administration -> Server Administration.

c. Select File -> Refresh Server list.

d. Verify that the same servers that indicated a status of Running in 
“Shutting-down MDM” (page 113) now indicate a status of Running.

4 If this MDM workstation is configured with the MDM Administration 
Database, enable access to the MDM Administration Database. 
Edit the file /opt/MagellanNMS/cfg/dba/dbaccess.cfg and set the 
parameter admindb.disabled to false.
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Backing-up MDM information
This section describes how to backup the Preside Multiservice Data Manager 
(MDM) configuration and data information on a MDM workstation.

Procedure navigation
• “Procedure prerequisites” (page 115)

• “Procedure steps” (page 115)

• “Job aids” (page 115)

Procedure prerequisites
• “Shutting-down MDM” (page 113)

Procedure steps
1 Log in to the MDM workstation as userID root.

2 Backup your MDM configuration and data information. If you are not 
backing-up the entire disk partition on which the MDM software resides, 
see “Backup directories” (page 115) for a list of Nortel Networks 
recommended MDM directories.

If this MDM workstation does not include the Management Data Provider 
(MDP), the directory /opt/MagellanMDP is not to be backed-up.

3 Restart the MDM. Follow the instructions in section “Restarting MDM” 
(page 114).

Job aids
Table 18
Backup directories

Location Comment
/opt/MagellanNMS/cfg
/opt/nortel/config MDM 15.1 and above.
/opt/MagellanNMS/data
/opt/nortel/data MDM 15.1 and above.
/opt/MagellanMDP/cfg
/opt/MagellanMDP/data
/opt/nortel/logs MDM 15.1 and above.
/opt/nortel/EPIC/cfg MDM 15.1 and above.
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Restoring MDM information
This section describes how to restore the Preside Multiservice Data Manager 
(MDM) configuration and data information on a MDM workstation.

Procedure navigation
• “Procedure prerequisites” (page 115)

• “Procedure steps” (page 115)

• “Job aids” (page 115)

Procedure prerequisites
• “Installing MDM software” (page 35)

Procedure steps
1 Log in to the MDM workstation as userID root.

2 Restore your MDM configuration and data information. If you are not 
restoring the entire disk partition on which the MDM software resides, see 
“Backup directories” (page 116) for a list of MDM directories to restore 
from your backups.

If this MDM workstation does not include the Management Data Provider 
(MDP), the directory /opt/MagellanMDP should not be restored.

3 Restart the MDM. Follow the instructions in section “Restarting MDM” 
(page 114).

Job aids
Table 19
Backup directories

Location Comment
/opt/MagellanNMS/cfg
/opt/nortel/config MDM 15.1 and above.
/opt/MagellanNMS/data
/opt/nortel/data MDM 15.1 and above.
/opt/MagellanMDP/cfg
/opt/MagellanMDP/data
/opt/nortel/logs MDM 15.1 and above.
/opt/nortel/EPIC/cfg MDM 15.1 and above.
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Appendix A
Installing X.25 software (DPN)

This section describes how to install Sun Microsystem Inc. X.25 software to 
access DPN switches from your Preside Multiservice Data Manager (MDM) 
workstation.

Navigation links
• “X.25 software installation task flow” (page 117)

• “Task navigation” (page 119)

X.25 software installation task flow
This task flow shows you the tasks you perform to install X.25 software on a 
Preside Multiservice Data Manager (MDM) workstation. To link to any task, 
go to “Task navigation” (page 119).
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X.25 software installation task flow

Installing 
X.25 

software

Installing X.25 
software 

(unbundled)

Installing X.25 
software 

(Solstice Server 
Connect)

End

Do you have the X.25 
software unbundled or 

the Solstice Server 
Connect package?

Determining the 
X.25 software 
requirements

Registering a 
license password
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Task navigation
• “Determining the X.25 software requirements” (page 120)

• “Installing X.25 software (unbundled)” (page 121)

• “Installing X.25 software (Solstice Server Connect)” (page 124)

• “Registering a license password” (page 127)
Preside MDM Installation Guide   15.1RSUP



120   Appendix A Installing X.25 software (DPN)
Determining the X.25 software requirements
Software packages on compact disk from SunSoft are combined into software 
subsets. Install the following software subsets:

• SunWx25a 9.2(X.25 kernel and include files for Solaris/SPARC)

• SUNWx25b 9.2 (X.25 user programs and libraries for Solaris/SPARC)

• SUNWx25h 1.1 (Solstice X.25 9.2 doc in HTML). 
The documentation is in HTML format and is useful for configuring and 
troubleshooting X.25 and IP over X.25 connections.
To view this documentation, Netscape version 3.0 or higher must be 
installed on the MDM workstation. 
When you click Help in Sun’s X.25 Administration Tool for the first 
time, you are prompted for the full path name to the Netscape executable.

• SUNWlicsw, FlexLM License System and SUNWlit License Installation 
Tool

The estimated disk space requirements for X.25 software are shown in the 
table “Estimated disk space requirements for X.25 software” (page 120).

Table 20 
Estimated disk space requirements for X.25 software

X.25 software subsets Approximate size

STE License Installation Tool 

(

SUNWlit2.0)

1 MByte

FlexLM License System (SUNWlicsw 4.1) 2 Mbyte

X.25 kernel modules and include files for Solaris/
SPARC (SunWx25a 9.2)

1 MByte

X.25 user programs and libraries for Solaris/SPARC 
(SUNWx25b 9.2)

1 Mbyte

Solstice X.25 9.2 documentation in HTML 
(SUNWx25h 1.1)

2 Mbyte

Total 7 Mbyte
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Installing X.25 software (unbundled)
Use the instructions in this procedure to install the X.25 software using a 
CD-ROM containing the Sunlink X.25 9.2 software, only.

Procedure navigation
• “Procedure prerequisites” (page 121)

• “Procedure steps” (page 121)

Procedure prerequisites
• “MDM workstation operating system” (page 29)

• “Determining the X.25 software requirements” (page 120)

• a CD-ROM drive is connected to the workstation and is powered up

• the workstation is displaying the login prompt

• you have the Sunlink X.25 9.2 software on compact disk. 
SunLink X.25 9.2 software is available on a compact disk as a discrete 
package or can be bundled with other SunSoft communications software 
referred to as the Solstice Server Connect package.

If you have the Server Server Connect software, do not continue. Follow 
the instructions in the procedure “Installing X.25 software (Solstice 
Server Connect)” (page 124).

Procedure steps
1 Log in as root.

2 Start c-shell

csh

3 Insert the compact disk into the CD-ROM drive, pattern side up. If your 
drive uses a disk caddy, insert the disk into the caddy pattern side up, then 
slide the disk caddy into the CD-ROM drive.

4 Open a UNIX window or a Shell Tool window.

5 Start up Sun’s admintool as a background process:

/usr/bin/admintool &

The admintool window opens.
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6 From the Browse menu, select Software.

The Admintool window now lists all software installed on the workstation.

7 From the Edit menu, select Add.

The Set Source Media dialog opens.

8 From Software Locations, select CD with Volume Management.

9 Type in the path name of the source media:

/cdrom/cdrom0

10 Click OK.

The Admintool: Add Software dialog opens and displays a list of the 
software on the CD.

11 Select the name of the name of the software to load.

12 Click Customize.

The Admintool: Customize Installation Dialog opens and displays a list of 
the software subsets to load. 

13 Select the software subsets you wish to load. For SunLink X.25 9.2, the 
minimum subsets are:

• STE License Installation Tool (SUNWlit2.0)

• FlexLM License System (SUNWlicsw 4.1)

• X.25 kernel modules and include files for Solaris/SPARC 
(SunWx25a 9.2)

• X.25 user programs and libraries for Solaris/SPARC 
(SUNWx25b 9.2)

• Solstice X.26 9.2 documentation in HTML (SUNWx25h 1.1)

14 When you have finished selecting the software subsets, click OK.

The Admintool: Customize Installation Dialog closes.

15 In the Admintool: Add Software Dialog, click Add.

The Command Input/Output dialog opens, and the software begins to 
load. This dialog displays prompts for confirmation (Y/N) at various stages 
as the software loads.

16 Answer all prompts for confirmation that appear in the Command 
Input/Output dialog by entering: Y
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When loading is complete, the Command Input/Output dialog displays a 
message to indicate that loading is successful and complete.

17 Eject the compact disk by typing the following command in the UNIX 
window or the shell tool window.

eject cdrom

18 Proceed to “Registering a license password” (page 127).
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Installing X.25 software (Solstice Server Connect)
Use the instructions in this procedure to install the X.25 software using a 
CD-ROM containing the Solstice Server Connect package.

Procedure navigation
• “Procedure prerequisites” (page 124)

• “Procedure steps” (page 124)

Procedure prerequisites
• “MDM workstation operating system” (page 29)

• “Determining the X.25 software requirements” (page 120)

• a CD-ROM drive is connected to the workstation and is powered up

• the workstation is displaying the login prompt

• you have the Sunlink X.25 9.2 software on compact disk. 
SunLink X.25 9.2 software is available on a compact disk as a discrete 
package or can be bundled with other SunSoft communications software 
referred to as the Solstice Server Connect package.

If you do not have the Solstice Server Connect package, do not continue. 
Follow the instructions in the procedure “Installing X.25 software 
(unbundled)” (page 121).

Procedure steps
1 Log in as root.

2 Start c-shell

csh

3 Insert the compact disk into the CD-ROM drive, pattern side up. If your 
drive uses a disk caddy, insert the disk into the caddy pattern side up, then 
slide the disk caddy into the CD-ROM drive.

4 Open a UNIX window or a Shell Tool window.

5 Start up Sun’s admintool as a background process:

/usr/bin/admintool &

The admintool window opens.
241-6001-100   15.1RSUP   



Appendix A Installing X.25 software (DPN)   125
6 From the Browse menu, select Software.

The Admintool window now lists all software installed on the workstation.

7 From the Edit menu, select Add.

The Set Source Media dialog opens.

8 From Software Locations, select CD with Volume Management.

9 Type in the path to the X.25 software:

/cdrom/server_connect_397/products/x25/Image/sparc

10 Click OK.

The Admintool: Add Software dialog opens and displays a list of the 
software on the CD.

11 Select the software subsets. For SunLink X.25 9.2, the minimum subsets 
are:

• X.25 kernel modules and include files for Solaris/SPARC 9.2 

• X.25 user programs and libraries for Solaris/SPARC 9.2

12 When you have finished selecting the software subsets, click Add.

The Command Input/Output dialog opens, and the software begins to 
load. This dialog displays prompts for confirmation (Y/N) at various stages 
as the software loads.

13 Answer all prompts for confirmation that appear in the Command Input/
Output dialog by entering: Y

When loading is complete, the Command Input/Output dialog displays a 
message to indicate that loading is successful and complete.

14 From the Edit menu, select Add.

The Admintool: Set Source Media dialog opens.

15 From Software Locations, select CD with Volume Management.

16 Type in the path to the X.25 licensing software:

/cdrom/server_connect_397/products/licenses/Image/
sparc

17 Click OK.

The Admintool: Add Software dialog opens and displays a list of the 
software on the CD.

18 Select the following licensing tool software:
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• Solstice Connect Center license information 4.1 License Installation 
Tool

• FlexLM License System

19 When you have finished selecting the software subsets, click Add.

The Command Input/Output dialog opens, and the software begins to 
load. This dialog displays prompts for confirmation (Y/N) at various stages 
as the software loads.

20 Answer all prompts for confirmation that appear in the Command Input/
Output dialog by entering: Y

When loading is complete, the Command Input/Output dialog displays a 
message to indicate that loading is successful and complete.

21 In the Admintool: Add Software Dialog, click the Set Source Media... 
button.

The Set Source Media dialog opens.

22 From Software Locations, select CD with Volume Management.

23 Type in the path to the X.25 documentation in HTML:

/cdrom/server_connect_397/products/licences/Docs/
sparc/

24 Select the following software subset:

• Solstice X.25 9.2 documentation in HTML (SUNWx25h 1.1)

25 Click OK.

The Command Input/Output dialog opens, and the software begins to 
load. This dialog displays prompts for confirmation (Y/N) at various stages 
as the software loads.

26 Answer all prompts for confirmation that appear in the Command Input/
Output dialog by entering: Y

When loading is complete, the Command Input/Output dialog displays a 
message to indicate that loading is successful and complete.

27 Eject the compact disk by typing in the following command in the UNIX 
window or the shell tool window.

eject cdrom

28 Proceed to “Registering a license password” (page 127).
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Registering a license password
Use the instructions in this procedure to register a license password to use the 
SunLink X.25 communications software. Perform this procedure on all 
Preside Multiservice Data Manager workstations on which the SunLink X.25 
software is installed.

Procedure navigation
• “Procedure prerequisites” (page 127)

• “Procedure steps” (page 127)

Procedure prerequisites
• “Installing X.25 software (unbundled)” (page 121) or

• “Installing X.25 software (Solstice Server Connect)” (page 124)

• Obtain a license from SunSoft to use the SunLink X.25 software. The 
license information must include the number of Rights to Use (RTUs), 
and the passwords to use SunLink X.25.

The number of RTUs defines the number of instances of the software that 
the license allows to run concurrently. For RTUs and passwords, contact 
Sun’s local license distribution center at the telephone number listed in 
the Sun documentation provided with the SunLink X.25 compact disk.

• Ensure that you have already loaded the SunLink X.25 application and 
software subsets: SUNWlicsw, FlexLM License System and SUNWlit 
License Installation Tool.

Procedure steps
1 Log in as root on the workstation on which SunLink X.25 software is 

installed.

2 If you have not already done so, access c-shell:

csh

3 Start the licensing tool:

/etc/opt/licenses/lit &

The License Installation Tool window opens.
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4 From Select Product, choose the name of the communications application 
for which you wish to install a password.

5 From Server Options, choose the number of servers on which the 
licensing server software is to run. For a standalone workstation, select 1.

6 In the Rights to Use field, type in the number of rights to use that are to 
be enabled with this password. The number of Rights to Use you enter 
must match that provided along with the password. 

7 In the Password field, type in the password you obtained from Sun’s local 
license distribution center.

8 Click Done With License.

9 Click Continue.

10 Click Exit - Install Licenses.

A script runs and when completed, a pop-up window appears containing 
a message which indicates that the license password has been installed.

11 Click Quit.

12 Install X.25 software patches as indicated by SunSoft.
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Configuring an X.25 link (DPN)

This section describes how to configure an X.25 communications link 
between the Preside Multiservice Data Manager (MDM) workstation and a 
DPN switch.

Navigation links
• “Configuring an X.25 link task flow” (page 129)

• “Task navigation” (page 131)

Configuring an X.25 link task flow
This task flow shows you the tasks you perform to configure X.25 software 
on a Preside Multiservice Data Manager (MDM) workstation. To link to any 
task, go to “Task navigation” (page 131).
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Configuring an X.25 link task flow
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Task navigation
• “Provisioning the X.25 link on DPN” (page 132)

• “Obtaining X.25 service parameters” (page 133)

• “Configuring an X.25 link” (page 136)
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Provisioning the X.25 link on DPN
Use the instructions in this procedure to provision the DPN switch to which 
the Preside Multiservice Data Manager (MDM) workstation is connected. 

Procedure steps
1 Provision the Network Control System (NCS) on all of the DPN switches 

in the network. For instructions to provision the NCS, see 241-2001-102 
DPN-100 Network Control System User Guide.

2 Provision the LAPB X.25 service on the Processing Element (PE), 
Peripheral Interface (PI), and Port (PO) on the DPN to which the MDM  
workstation is connected. For the instructions to provision the LAPB X.25 
service on a PE and PI, see 241-1001-184 DPN-100 LAPB/X.25 
Specification.
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Obtaining X.25 service parameters
Use the instructions in this procedure to obtain information about the LAPB 
X.25 service provisioned on the DPN port to which the Preside Multiservice 
Data Manager (MDM) workstation is connected.

Procedure navigation
• “Procedure steps” (page 133)

• “Job aids” (page 133)

Procedure steps
1 At a maintenance terminal connected to the DPN switch, type the 

following sequence of commands:

[PI] <n> [PO] <m> Query SERVice

[PI] <n> [PO] <m> Query DNA

[PI] <n> [PO] <m> Query LINK

[PI] <n> [PO] <m> Query LCN

Print the results of the above commands. The service parameters 
required for successful X.25 link configuration are described in “Service 
parameters” (page 134).

Job aids
Table 21 
Variable definitions

Variable Definition

n is the number of the Peripheral Interface (PI) 
card

m is the number of the port (PO) on the PI card to 
which the MDM workstation is connected
Preside MDM Installation Guide   15.1RSUP



134   Appendix B Configuring an X.25 link (DPN)
Table 22
Service parameters

Parameter Description

link number The link number for the interface you are 
defining. If this is the first link you are defining, 
this must be link 0.

link type The type of link. It must be WAN.

device The type of device to which the X.25 link is 
connected on the workstation. The device type is 
ZSH for a low-speed port or HSI for a high-speed 
port on an HSI/P card.

port number The workstation port to which the X25 link is 
connected. The port number must correspond to 
the physical workstation port. Most 
SPARCstations are equipped with two low-
speed serial ports labelled A and B. The port 
labelled A is port 0 (ZSH-0) and the port labelled 
B is Port 1 (ZSH-1). When an HSI card is 
installed in the workstation, the workstation has 
four additional high-speed ports labelled 0 
through 3.

local X.121 address The X.121 address of the port on the DPN 
peripheral interface card to which the workstation 
is connected. This address includes the Data 
Network Identification Code (DNIC), the Network 
Terminal Number (NTN), and any sub-
addressing digits.
You only need to include the DNIC if the 
information displayed with the [PI] n [PO] m Q 
DNA command shows that DNIC is set to 
international format OFF/NO.

 (Sheet 1 of 2)
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version The version of X.25 software running on the link. 
The version must match the version of X.25 
software provisioned on the DPN port to which 
the workstation connects.

SVC Two-Way Logical 
Channel Range

The lowest and the highest number logical 
channel number on which an SVC is set up for 
X.25 communication. The range must match the 
minimum and maximum values configured in 
NCS. You can obtain these values by entering 
the following command at a maintenance 
terminal connected to the DPN switch.
[PI] <n> [PO] <m> Query LCN

Table 22
Service parameters

Parameter Description

 (Sheet 2 of 2)
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Configuring an X.25 link
Use the instructions in the following procedure to configure an X.25 link from 
the Preside Multiservice Data Manager (MDM) workstation to a DPN switch 
using the Sun Microsystems Inc. X.25 Administration tool. 

Some of the X.25 service parameters are critical, but for others the default 
values provided with the tool are adequate. The following procedure sets the 
critical values and leaves the others at their defaults. This is adequate for most 
installations. All settings are network dependent and may require fine tuning 
for efficient and stable operation of the X.25 link.

Procedure navigation
• “Procedure prerequisites” (page 136)

• “Procedure steps” (page 136)

Procedure prerequisites
• “Installing X.25 software (DPN)” (page 117)

• “Provisioning the X.25 link on DPN” (page 132)

• “Obtaining X.25 service parameters” (page 133)

Procedure steps
1 Log in as root.

2 Open a UNIX xterm.

3 Start the X.25 Administration tool:

/opt/SUNWconn/bin/x25tool &

The x25tool 9.2 main window opens and displays a set of default links.

4 From the Options menu, select Dynamic Mode.

5 From the Options menu, select Start X.25 automatically when booted.

6 Remove all default links displayed in the main window.

To remove a link, click on the name of the link to select it, then click the 
Delete button.

7 In the main window, click the Add... button.

A dialog opens that displays a list of link types.
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8 Click Default.

The Link Editor window opens. This window contains fields you must fill in 
to define an X.25 link.

9 Enter the link number in the Link Number field. For the very first link, 
enter 0. For the subsequent link enter 1, and so on.

10 Enter a descriptive name for the link in the Link Description field. For 
example: Internal Serial Port.

11 Select WAN from the Link Type menu button.

12 Select a device type from the Device menu button.

The device type must match the type of interface on the workstation to 
which the X.25 link is connected. The device type is ZSH for a link that 
connects to a low-speed port on the workstation or HSI for a link that 
connects to a high-speed port on an HSI/S card.

13 Enter the port number in the Port Number field.

The port number must correspond to the physical workstation port to 
which the X.25 link is connected. Most SPARCstations are equipped with 
two low-speed serial ports labelled A and B. The port labelled A is port 0 
(ZSH-0) and the port labelled B is Port 1 (ZSH-1). When an HSI card is 
installed in the workstation, the workstation has four additional high-speed 
ports labelled 0 through 3. 

14 Enter the workstation local address into the Local X.121 Address field.

This is the X.121 address of the port on the DPN peripheral interface card 
to which the workstation is connected. This address includes the Data 
Network Identification Code (DNIC), the Network Terminal Number 
(NTN), and any sub-addressing digits. 

You only need to include the DNIC if the information displayed with 
[PI] n [PO] m Q DNA command shows that DNIC is set to international 
format OFF/NO. 

15 Select the version of X.25 software using the Version menu button.

This version must match the version of X.25 software provisioned on the 
DPN port to which the workstation connects.

16 Set the Packet Size menu buttons as follows:

Local:  default: 512   maximum: 512
Remote: default: 512    maximum: 512

17 Set the SVC Two-Way Logical Channel Range menu buttons to match the 
minimum and maximum values configured in NCS. Obtain these values 
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by entering the following command at command at a maintenance 
terminal connected to the DPN switch:

[PI] <n> [PO] <m> Query LCN

18 Set the PVC, SVC Incoming, and SVC Outgoing Logical Channel Range 
menu buttons as follows:

PVC                minimum: 0   maximum: 0

SVC Incoming       minimum: 0   maximum: 0
SVC Outgoing       minimum: 0   maximum: 0

19 Click Apply to activate the Advanced Configuration buttons in the main 
window that provide access to dialogs for configuring WAN links.

Lettering on the appropriate buttons turns from gray to black to indicate 
that they are active.

Note:  You are about to click on the Advanced Configuration buttons, one 
at a time. Clicking a button opens a dialog into which you enter service 
information, apply the information, then close the dialog. However, you 
are only going to click CUG and Facilities, Link Modes, and Throughput. 
It is not necessary to click the remaining buttons to open the 
accompanying dialogs and set values in them because the default values 
in these dialogs are satisfactory for most installations.

20 From the Advanced Configuration list, select CUG and Facilities.

The Closed User Groups and Facilities Parameters dialog opens.

21 Click on the following check boxes to select them:

Closed User Group: CUG, no other access

Facilities: Incoming reverse charging

Size Negotiation: Request Size Negotiation

Fast Select: With no restriction on response

22 Leave all other check boxes deselected (empty) and the CUG Format 
menu button set to Basic.

23 Click Apply, then OK.

The Closed User Groups and Facilities Parameters dialog closes.

24 In the Link Editor window, click Link Modes.

The Link Mode Parameters dialog opens.
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25 If outgoing X25 calls are international, set the Outgoing International Calls 
menu button to Check National DNIC, and enter your Data Network 
International Code (DNIC) in the DNIC field.

26 Leave all other menu buttons set to their default values and all other check 
boxes deselected.

27 Click Apply, then OK.

The Link Mode Parameters dialog closes.

28 In the Link Editor window, click Throughput.

The Throughput Classes and Window Sizes Parameters dialog opens.

29 Enter the following values into the Throughput Class fields:

Local minimum:  3    default: 12   maximum:12
Remote minimum: 3    default: 12   maximum:12

30 For Negotiate Toward Default, click the Yes toggle button.

31 For Packet Size, enter 517 in the Max NSDU Length field.

32 For Network Profile, leave Modulo set to 8.

33 Enter the following values in the Window Size fields:

Local  default: 2    maximum:7
Remote  default: 2   maximum:7

34 Click Apply then OK.

The Throughput Classes and Window Sizes Parameters dialog closes.

35 In the Link Editor window, click Apply, then OK.

The Link Editor window closes.

36 In the x25tool 9.2 window, select Save from the File menu.

The Save Information in Default Configuration dialog opens.

37 Click OK.

The information about the new link is saved as part of the default 
configuration, and the dialog closes.

38 In the x25tool 9.2 window, choose Start X25 from the Network menu.

39 Ensure that the link you created is still highlighted, then select Start Link 
from the Network menu.

Progress messages are displayed in the x25tool 9.2 window as the link is 
started.
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Configuring an IP over X.25 link 
(DPN/Passport)

Use the instructions in this section to configure an IP connection between the 
Preside Multiservice Data Manager (MDM) workstation and a Passport 
switch using an X.25 communications link to a DPN gateway switch.

Configure each IP over X.25 connection to a Passport switch as a point-to-
point connection. Configuring a point-to-point connection involves 
configuring service parameters in two dialogs that can be opened from the 
Services menu of the x25tool 9.2 window.

To configure a point-to-point connection, the first dialog you open is the IP 
Interface Configuration Dialog. In this dialog, add the local IP address of the 
workstation, the remote IP address of the Passport switch, and specify the 
connection as a point-to-point connection. From this dialog, you must also 
open a sub-dialog to specify advanced IP over X.25 configuration parameters.

The second dialog you open is the Remote Host to X.25 Map dialog. In this 
dialog, you specify information that maps the Remote X.25 address you 
entered in the IP Interface Configuration Dialog to the DNA of the Passport 
switch.

For each point-to-point connection, add IP interface information into the IP 
Interface Configuration dialog, then add mapping information into the 
Remote Host to X.25 Map dialog.
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Procedure navigation
• “Procedure prerequisites” (page 142)

• “Procedure steps” (page 142)

Procedure prerequisites
• “Configuring an X.25 link (DPN)” (page 129)

• the IP address of the MDM workstation

This is the address labelled localhost in file /etc/hosts.

• the Data Network Address (DNA) of the MDM workstation

The DNA must match the one you provisioned in the Link Editor dialog 
when you configured the X.25 link to the DPN switch.

• the Link Number of the X.25 link.

The Link Number must match the one you provisioned in the Link Editor 
dialog when you configured the X.25 link to the DPN switch.

• the DNA of the remote Passport switch and its corresponding IP address

Obtain this information from your Passport network administrator.

Procedure steps
1 Log in as root.

2 Open a UNIX xterm.

3 Start the X.25 Administration tool:

/opt/SUNWconn/bin/x25tool &

The x25tool 9.2 window opens.

4 Choose Dynamic Mode from the Options menu.

5 Choose IP->IP Interface from the Services menu.

The IP Interface Configuration dialog opens.

6 If there are any default IP interfaces defined, select them one at time and 
click Delete.
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7 Click Add.

The fields and buttons in the lower half of the dialog turn from gray to black 
to indicate that they are active.

8 Enter the following values in the fields dialog:

Local IP address:

This is the IP address of the workstation.

Remote IP address:

This is the IP address of the Passport switch.

9 Set the Point to: menu button to Point.

10 Leave the MTU field set to the default of 576.

11 Click Apply.

The local and remote IP address information you just entered is added to 
list of mappings in the upper half of the dialog.

12 Ensure that the mapping is still selected (highlighted).

13 Click Modify.

The X.25 Parameters Advanced Configuration Parameters button turns 
from gray to black to indicate that it is active.

14 Click X.25 Parameters.

The X25 Configuration IP Address dialog opens.

15 Enter the pre-emption timeout in the Pre-emption Timer field. 

This is the number of seconds that a connection must be idle before it can 
be closed (pre-empted) for another purpose. When all X.25 circuits 
available to the IP application are in use and an IP packet arrives for 
transmission to a new destination, SunLink closes the connection that has 
been idle the longest. The preemption timer determines the minimum time 
a connection must be idle before it can be preempted in this way.

If the workstation is being used for surveillance or data collection, you 
must set this timer to at least 6000 to avoid undesired teardown of 
Passport VC connections and to keep the communications path to the 
Passport stable. However, if the workstation is not being used for 
purposes that require the connection to remain up, say for entering 
commands, you can set the preemption timer to a lower value.

16 Enter the disconnection timeout in the Disconnection Timer field.
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This is the time in seconds that a connection to a given network can 
remain idle before being closed. For a value of 6000, this represents 100 
minutes.

If the workstation is being used for surveillance or data collection, you 
must set this timer to at least 6000 to avoid undesired teardown of 
Passport VC connections and to keep the communications path to the 
Passport stable. However, if the workstation is not being used for 
purposes that require the connection to remain up, say for entering 
commands, you can set the disconnection timer to a value of less than 
300. Why less than 300? This is because when a connection is set up, the 
Passport sends a reset packet after 5 minutes (value of 300), then every 
3 minutes (value of 180) thereafter.

17 Leave all other items in this dialog set at their default values.

18 Click Apply, then OK.

The X25 Configuration for IP Interface dialog closes.

19 In the x25tool 9.2 window, choose IP->IP Mapping from the Services 
menu.

The Remote IP Host to X.25 Address Map dialog opens.

20 In the dialog, click Add.

The fields and buttons in the lower half of the dialog turn from gray to black 
to indicate that they are active.

21 Enter the following values into the dialog:

Remote IP address

This the IP address of the Passport switch. This address must match the 
IP address of the Passport switch you entered in the IP Interface 
Configuration Dialog.

Link number

This is the number of the X.25 link on which the IP application is running. 
It must match the link number you entered in the Link Editor window when 
you configured X.25 on the link.

Remote X.25 address

This is the DNA that corresponds to the IP address of the Passport switch.

22 Leave the other parameters in this dialog at their default values.
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Note:  It is not necessary to click the Advanced Configuration X.25 
Parameters button to specify X.25 parameters in the X25 Configuration for 
IP dialog because the default values in the dialog are adequate for most 
installations.

23 Click Apply, then OK.

The Remote IP Host to X.25 Address Map dialog closes.

24 In the x.25tool 9.2 window, choose Save from the File menu.

25 Enter the following command to verify that the connection to the Passport 
switch is up:

ping <ip address>

where:

<ip address> is the IP address of the Passport switch. If the 
connection is up, the following response appears:

<ip address> is alive
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Installing frame relay software

This section describes how to install and configure Sun Microsystem Inc. 
frame relay (FR) software to access Passport switches from your Preside 
Multiservice Data Manager (MDM) workstation.

Navigation links
• “Frame relay software installation task flow” (page 147)

• “Task navigation” (page 149)

Frame relay software installation task flow
This task flow shows you the tasks you perform to install and configure frame 
relay software on a Preside Multiservice Data Manager (MDM) workstation. 
To link to any task, go to “Task navigation” (page 149).
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Frame relay software installation task flow
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Task navigation
• “Provisioning the frame relay link on a Passport” (page 150)

• “Determining the frame relay software requirements” (page 151)

• “Installing frame relay software (unbundled)” (page 152)

• “Installing frame relay software (Solstice Server Connect)” (page 155)

• “Registering a license password” (page 158)

• “Configuring a frame relay link” (page 160)
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Provisioning the frame relay link on a Passport
Use the instructions in this procedure to provision the Passport switch to 
which the Preside Multiservice Data Manager (MDM) workstation is 
connected. 

Procedure steps
1 Provision an IP over frame relay (IPIFR) interface on the Passport switch 

as described in 241-5701-270 Passport 7400, 15000, 20000 Software 
Installation Guide.

a. Provision the interface as a static IP connection to function as a 
Permanent Virtual Circuit.

b. The clock speed is set by the Passport switch.

c. Set the <proc> option of Lmi to none.

d. Set maximumFrameSize to 1600.

e. Set all other components values to the values specified in 
241-5701-270 Passport 7400, 15000, 20000 Software Installation 
Guide.
241-6001-100   15.1RSUP   



Appendix D Installing frame relay software   151
Determining the frame relay software requirements
Software packages on compact disk from SunSoft are combined into software 
subsets. 

Load all of the software subsets in the SunLink frame relay package version 
2.0.1, except for any Answerbook software subsets that contain Sun 
Microsystems Inc. online documentation. The minimum workstation 
configuration does not include disk space allowances for Answerbook 
subsets. If you choose to load the Answerbooks, increase the allowances for 
partition sizes and/or disk space capacity accordingly.

The estimated disk space requirements for frame relay software are shown in 
the table “Estimated disk space requirements for SunLink frame relay 
software” (page 151).

Table 23 
Estimated disk space requirements for SunLink frame relay software

SunLink rame relay software subsets Approximate size

Solstice Frame Relay 2.0.1 driver and configuration 
(SUNWfra 2.0.1)

1 Mbyte

Solstice Frame Relay 2.0.1 application programs 
(SUNWfrab 2.0)

1 Mbyte

Total 2 Mbyte
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Installing frame relay software (unbundled)
Use the instructions in this procedure to install the frame relay software using 
a CD-ROM containing the Sunlink frame relay 2.0.1 software, only.

Procedure navigation
• “Procedure prerequisites” (page 152)

• “Procedure steps” (page 152)

Procedure prerequisites
• “Provisioning the frame relay link on a Passport” (page 150)

• “Determining the frame relay software requirements” (page 151)

• a CD-ROM drive is connected to the workstation and is powered up

• the Solaris operating system is installed and configured

• the workstation is displaying the login prompt

• you have the Sunlink frame relay 2.0 software on compact disk. 
SunLink frame relay 2.0 software is available on a compact disk as a 
discreet package or can be bundled with other SunSoft communications 
software referred to as the Solstice Server Connect package.

If you have the Server Server Connect software, do not continue. Follow 
the instructions in the procedure “Installing frame relay software 
(Solstice Server Connect)” (page 155).

Procedure steps
1 Log in as root.

2 Start c-shell

csh

3 Insert the compact disk into the CD-ROM drive, pattern side up. If your 
drive uses a disk caddy, insert the disk into the caddy pattern side up, then 
slide the disk caddy into the CD-ROM drive.

4 Open a UNIX window or a Shell Tool window.

5 Start up Sun’s admintool as a background process:

/usr/bin/admintool &
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The admintool window opens.

6 From the Browse menu, select Software.

The Admintool window now lists all software installed on the workstation.

7 From the Edit menu, select Add.

The Set Source Media dialog opens.

8 From Software Locations, select CD with Volume Management.

9 Type in the path name of the source media:

/cdrom/cdrom0

10 Click OK.

The Admintool: Add Software dialog opens and displays a list of the 
software on the CD.

11 Select the name of the name of the software to load.

12 Click Customize.

The Admintool: Customize Installation Dialog opens and displays a list of 
the software subsets to load. 

13 Select the following software subsets:

• Solstice Frame Relay driver and configuration files 2.0.1

• Solstice Frame Relay 2.0.1 application programs 2.0.1

Note:  Do not select any Answerbook subsets. These subsets contain 
Sun Microsystems Inc. online documentation. The minimum workstation 
configuration does not include sufficient disk space for the frame relay 
Answerbook. If you choose to load Answerbook subsets, you must 
increase partition sizes and/or disk space accordingly.

14 When you have finished selecting the software subsets, click OK.

The Admintool: Customize Installation Dialog closes.

15 In the Admintool: Add Software Dialog, click Add.

The Command Input/Output dialog opens, and the software begins to 
load. This dialog displays prompts for confirmation (Y/N) at various stages 
as the software loads.

16 Answer all prompts for confirmation that appear in the Command 
Input/Output dialog by entering: Y
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When loading is complete, the Command Input/Output dialog displays a 
message to indicate that loading is successful and complete.

17 Eject the compact disk by typing the following command in the UNIX 
window or the shell tool window.

eject cdrom

18 Proceed to “Registering a license password” (page 158).
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Installing frame relay software (Solstice Server Connect)
Use the instructions in this procedure to install the SunLink frame relay 
software using a CD-ROM containing the Solstice Server Connect package.

Procedure navigation
• “Procedure prerequisites” (page 155)

• “Procedure steps” (page 155)

Procedure prerequisites
• “Provisioning the frame relay link on a Passport” (page 150)

• “Determining the frame relay software requirements” (page 151)

• a CD-ROM drive is connected to the workstation and is powered up

• the Solaris operating system is installed and configured

• the workstation is displaying the login prompt

• you have the Sunlink frame relay 2.0 software on compact disk. 
SunLink frame relay 2.0 software is available on a compact disk as a 
discreet package or can be bundled with other SunSoft communications 
software referred to as the Solstice Server Connect package.

If you do not have the Solstice Server Connect package, do not continue. 
Follow the instructions in the procedure “Installing frame relay software 
(unbundled)” (page 152).

Procedure steps
1 Log in as root.

2 Start c-shell

csh

3 Insert the compact disk into the CD-ROM drive, pattern side up. If your 
drive uses a disk caddy, insert the disk into the caddy pattern side up, then 
slide the disk caddy into the CD-ROM drive.

4 Open a UNIX window or a Shell Tool window.

5 Start up Sun’s admintool as a background process:

/usr/bin/admintool &
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The admintool window opens.

6 From the Browse menu, select Software.

The Admintool window now lists all software installed on the workstation.

7 From the Edit menu, select Add.

The Set Source Media dialog opens.

8 From Software Locations, select CD with Volume Management.

9 Type in the path to the frame relay software:

/cdrom/server_connect_397/products/frelay/Image/sparc

10 Click OK.

The Admintool: Add Software dialog opens and displays a list of the 
software on the CD.

11 Select the following software subsets:

• Solstice Frame Relay driver and configuration files 2.0.1

• Solstice Frame Relay 2.0.1 application programs 2.0.1

Note:  Do not select any Answerbook subsets. These subsets contain 
Sun Microsystems Inc. online documentation. The minimum workstation 
configuration does not include sufficient disk space for the frame relay 
Answerbook. If you choose to load Answerbook subsets, you must 
increase partition sizes and/or disk space accordingly.

12 When you have finished selecting the software subsets, click Add.

The Command Input/Output dialog opens, and the software begins to 
load. This dialog displays prompts for confirmation (Y/N) at various stages 
as the software loads.

13 Answer all prompts for confirmation that appear in the Command Input/
Output dialog by entering: Y

When loading is complete, the Command Input/Output dialog displays a 
message to indicate that loading is successful and complete.

14 From the Edit menu, select Add.

The Admintool: Set Source Media dialog opens.

15 From Software Locations, select CD with Volume Management.

16 Type in the path to the Solstice licensing software:
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/cdrom/server_connect_397/products/licenses/Image/
sparc

17 Click OK.

The Admintool: Add Software dialog opens and displays a list of the 
software on the CD.

18 Select the following licensing tool software:

• Solstice Connect Center license information 4.1 License Installation 
Tool

• FlexLM License System

19 When you have finished selecting the software subsets, click Add.

The Command Input/Output dialog opens, and the software begins to 
load. This dialog displays prompts for confirmation (Y/N) at various stages 
as the software loads.

20 Answer all prompts for confirmation that appear in the Command Input/
Output dialog by entering: Y

When loading is complete, the Command Input/Output dialog displays a 
message to indicate that loading is successful and complete.

21 Eject the compact disk by typing in the following command in the UNIX 
window or the shell tool window.

eject cdrom

22 Proceed to “Registering a license password” (page 158).
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Registering a license password
Use the instructions in this procedure to register a license password to use the 
SunLink frame relay communications software. Perform this procedure on all 
Preside Multiservice Data Manager workstations on which the SunLink 
frame relay software is installed.

Procedure navigation
• “Procedure prerequisites” (page 158)

• “Procedure steps” (page 158)

Procedure prerequisites
• “Installing frame relay software (unbundled)” (page 152) or

• “Installing frame relay software (Solstice Server Connect)” (page 155)

• Obtain a license from SunSoft to use the SunLink frame relay software. 
The license information must include the number of Rights to Use 
(RTUs), and the passwords to use SunLink frame relay.

The number of RTUs defines the number of instances of the software that 
the license allows to run concurrently. For RTUs and passwords, contact 
Sun’s local license distribution center at the telephone number listed in 
the Sun documentation provided with the SunLink frame relay compact 
disk.

• Ensure that you have already loaded the SunLink software subsets: 
SUNWlicsw, FlexLM License System and SUNWlit License Installation 
Tool.

Procedure steps
1 Log in as root on the workstation on which SunLink frame relay software 

is installed.

2 If you have not already done so, access c-shell:

csh

3 Start the licensing tool:

/etc/opt/licenses/lit &

The License Installation Tool window opens.
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4 From Select Product, choose the name of the communications application 
for which you wish to install a password.

5 From Server Options, choose the number of servers on which the 
licensing server software is to run. For a standalone workstation, select 1.

6 In the Rights to Use field, type in the number of rights to use that are to 
be enabled with this password. The number of Rights to Use you enter 
must match that provided along with the password. 

7 In the Password field, type in the password you obtained from Sun’s local 
license distribution center.

8 Click Done With License.

9 Click Continue.

10 Click Exit - Install Licenses.

A script runs and when completed, a pop-up window appears containing 
a message which indicates that the license password has been installed.

11 Click Quit.

12 Install frame relay software patches as indicated by SunSoft.
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Configuring a frame relay link
Use the instructions in this procedure to configure a frame relay link from the 
Preside Multiservice Data Manager (MDM) workstation to a Passport switch.

Note: Nortel Networks recommends that you do not use the SunLink 
frame relay utilities to configure and launch the frame relay link.

Procedure navigation
• “Procedure steps” (page 160)

• “Job aids” (page 160)

Procedure prerequisites
• “Registering a license password” (page 158)

Procedure steps
1 As the UNIX userID root, open an Xterm.

2 At the command line prompt, type

/opt/MagellanNMS/bin/passport.frconfig

For instructions to use this command, see 241-6001-303 Preside MDM 
Administrator Guide.

Respond to the prompts using the descriptions of the frame relay service 
parameters in “Service parameters” (page 160).

Job aids
Table 24
Service parameters

Parameter Description

IP address (MDM) the IP address of the Preside Multiservice Data 
Manager (MDM) workstation

IP address (Passport) the IP address of the Passport switch

link name the name of the frame relay interface on the 
workstation (hih0, hih1, hih2, or hih3)

 (Sheet 1 of 2)
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DLCI the Data Link Connection Identifier of the frame 
relay connection. Obtain the DLCI from your 
Passport Network Administrator.

clocking the clocking for the link, which should always be 
external

MTU size the Maximum Transmission Unit (MTU) size. The 
default value of 1500 should suffice for most 
installations.

Table 24 (Continued)
Service parameters

Parameter Description

 (Sheet 2 of 2)
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Installing ATM software

This section describes how to install and configure Sun Microsystem Inc. 
SunATM software to access Passport switches from your Preside 
Multiservice Data Manager (MDM) workstation.

Navigation links
• “ATM software installation task flow” (page 163)

• “Task navigation” (page 165)

ATM software installation task flow
This task flow shows you the tasks you perform to install and configure ATM 
software on a Preside Multiservice Data Manager (MDM) workstation. To 
link to any task, go to “Task navigation” (page 165).
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ATM software installation task flow

Installing 
ATM 

software

Determining the 
ATM software 
requirements

Provisioning the 
ATM  link on a 

Passport

End

Configuring an 
ATM link

Installing ATM 
software
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Task navigation
• “Provisioning the ATM link on a Passport” (page 166)

• “Determining the ATM software requirements” (page 167)

• “Installing ATM software” (page 168)

• “Configuring an ATM link” (page 170)
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Provisioning the ATM link on a Passport
Use the instructions in this procedure to provision the Passport switch to 
which the Preside Multiservice Data Manager (MDM) workstation is 
connected. 

Procedure steps
1 Provision ATM interface (ATMIF) and an ATM multi-protocol encapsulation 

(MPE) components on the Passport switch as described in 241-5701-270 
Passport 7400, 15000, 20000 Software Installation Guide.

a. Provision the interface as a nailed-up end point (NEP) to function as 
a Permanent Virtual Circuit.

b. The virtual connection identifier (VCI) number on the Passport switch 
is the same as the PVC number on the MDM workstation in the ATM 
network interface card (NIC) configuration.

c. Set maximum transmission unit (MTU) to 9180.

d. Provision the static IP address as the instance of the host under the 
Virtual Router (VR) on the Passport switch and ensure that this IP 
address is the same IP address assigned to the SunATM NIC card on 
the MDM workstation.

e. Set all other components values to the values specified in 
241-5701-270 Passport 7400, 15000, 20000 Software Installation 
Guide.
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Determining the ATM software requirements
Software packages on compact disk from SunSoft are combined into software 
subsets. Load all of the software subsets in the SunATM (version 4.0, or later) 
package

The estimated disk space requirements for SunATM software are shown in 
the table “Estimated disk space requirements for SunATM software” 
(page 167).

Table 25 
Estimated disk space requirements for SunATM software

SunATM software subsets Approximate size

SunATM device drivers and utilities <1 Mbyte

SunATM interim API support software (optional) <1 Mbyte

SunATM runtime support software (optional) <1 Mbyte

Total <3 Mbyte
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Installing ATM software
Use the instructions in this procedure to install the ATM software using a 
CD-ROM containing the SunATM software.

Procedure navigation
• “Procedure prerequisites” (page 168)

• “Procedure steps” (page 168)

Procedure prerequisites
• Install an ATM NIC card in the MDM workstation and ensure that the 

workstation is connected to the network. For more information, see the 
SunATM Installation and User’s Guide. 

• “Provisioning the ATM link on a Passport” (page 166)

• “Determining the ATM software requirements” (page 167)

• a CD-ROM drive is connected to the workstation and is powered up

• the Solaris operating system is installed and configured

• the workstation is displaying the login prompt

• you have the SunATM 4.0 (or later) software on compact disk.

Procedure steps
1 Log in as root.

2 Start c-shell

csh

3 Insert the compact disk into the CD-ROM drive, pattern side up. If your 
drive uses a disk caddy, insert the disk into the caddy pattern side up, then 
slide the disk caddy into the CD-ROM drive.

4 Open a UNIX window or a Shell Tool window.

5 Add the SunATM software package.

/usr/sbin/pkgadd -d/cdrom/sunatm_4_0/Product SUNWatm 
[SUNWatmu SUNWatma]

The SunATM package(s) will be installed in the following directories:
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• SunATM Device Drivers and Utilities (SunWatm) go into /kernel/mod, 
/kernel/mod/sparcv9, /kernel/drv, /etc/init.d, /platform/SUN, Ultra-
4FT/kernel/drv, /kernel/drv/sparcv9, /etc/opt/SUNWconn/atm, /etc/
rc2.d and /etc/opt/SUNWconn/bin.

• SunATM Runtime Support software (SUNWatmu) goes into 
/opt/SUNWconn/atm and /opt/SUNWconn/man.

• SunATM Interim API (SunWatma) goes into /opt/SUNWconn/atm/
include, /opt/SUNWconn/atm/lib, /opt/SUNWconn/include and /opt/
SUNWconn/lib.

6 Eject the SunATM CD-ROM.

7 Configure your SunATM interface. See “Configuring an ATM link” 
(page 170).

8 Reboot the workstation and examine the network interface.

9 Use the boot -rv command from the ok prompt.

10 Execute ifconfig -a and netstat -i commands to examine the state of all 
network interfaces. You can also use the /usr/sbin/ping command to see 
if a network interface is active.
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Configuring an ATM link
Use the instructions in this procedure to configure an ATM link from the 
Preside Multiservice Data Manager (MDM) workstation to a Passport switch.

An ATM link can also be configured on the MDM workstation using the 
MDM Installer tool.

Procedure navigation
• “Procedure steps” (page 170)

• “Job aids” (page 170)

Procedure prerequisites
• “Installing ATM software” (page 168)

Procedure steps
1 As the UNIX userID root, open an Xterm.

2 At the command line prompt, type

/opt/MagellanNMS/bin/passport.atmconfig

For instructions to use this command, see 241-6001-303 Preside MDM 
Administrator Guide.

Respond to the prompts using the descriptions of the ATM service 
parameters in “Service parameters” (page 170).

Job aids
Table 26
Service parameters

Parameter Description

IP address (MDM) the IP address of the Preside Multiservice Data 
Manager (MDM) workstation

IP address (Passport) the IP address of the Passport switch

 (Sheet 1 of 2)
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PVC number the PVC number input during the SunATM 
configuration of the MDM workstation must 
match the VCI number used on the Passport 
switch. An example of a VPI.VCI number on the 
switch is 0.50, where 0 is the VPI and 50is the 
VCI number.

Note:  The PVC number on the switch under the 
Virtual Router Static Host configuration does not 
correspond to the PVC number in the SunATM 
configuration. Instead, the Virtual Router Static 
Host PVC number on switch must correspond to 
the instance number of the atmConnection under 
the ATMMPE component on switch.

signaling level set the signaling level to 4.0 in the SunATM 
configuration

Table 26 (Continued)
Service parameters

Parameter Description

 (Sheet 2 of 2)
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Appendix F
HP OpenView Desktop

This section describes how to configure the Hewlett-Packard (HP) OpenView 
Desktop for use with the Preside Multiservice Data Manager (MDM). 

The HP OpenView Desktop is a 3rd-party application used to display network 
fault information. The HP OpenView Desktop is an optional feature provided 
with the MDM software.

Note: Nortel Networks does not support the installation of the HP 
OpenView Desktop on the same workstation as the MDM SNMP 
Surveillance Adapter or on the same workstation as MDM device 
integration cartridges.

Procedure navigation
• “Procedure navigation” (page 173)

• “Procedure steps” (page 174)

• “Job aids” (page 175)

Procedure prerequisites
• the node name or IP address of the MDM workstation with the primary 

NDAM server

• the node name or IP address of the MDM workstation with the backup 
NDAM (optional)

• the name of the device set file (optional)
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Procedure steps
1 Log in as root.

2 Edit the file

/etc/opt/OV/share/conf/C/nortel/nms/odn/ovdam.cfg

3 Add as the first line, a line that specifies the location of the primary NDAM 
server. Use the following syntax:

ndamServer: NDAM<service_name>@<host|ip_address>

4 Add an entry for an alternate NDAM server that can be used as a backup 
source for surveillance information, if an alternate NDAM server is 
available (optional).

5 To filter surveillance information, add a line that specifies the name of the 
device set file (optional). The device set file must exist on the workstation 
that runs the NDAM server. The syntax of an entry is:

deviceSet: <device set>

Note:  The file ovdam.cfg contains an entry that specifies the name of the 
default typeset file used by NDAM. Do not modify this entry. An example 
of this entry follows:

compTypeSet: OMS_Passport

6 Save the file and close it.

7 Ensure that the file permissions are set to read-write-execute by user, and 
read-execute by group and by others:

chmod 755 /etc/opt/OV/share/conf/C/nortel/nms/odn/
ovdam.cfg

8 Restart the OVDAM and OVAT processes:

/opt/OV/bin/ovstart ovdam

/opt/OV/bin/ovstart ovat

9 List the status of OV processes:

/opt/OV/bin/ovstatus

Ensure that the following processes are running:

OVsPMD
ovwdb
pmd
241-6001-100   15.1RSUP   



Appendix F HP OpenView Desktop   175
ovat
ovdam
OVLicenseMgr

10 If one of the processes identified in step 9 is not running, start it by 
entering the command:

/opt/OV/bin/ovstart <process_name>

Job aids
Table 27
Variable definitions

Variable Definition

<service_name> the service name of the NDAM process. If there 
is only one NDAM process running on the 
workstation and you chose not to specify a 
service name in the command to start the NDAM 
process, enter NDAM and omit the service 
name.

<host | ip_address> the host name or IP address of the workstation 
that runs NDAM. To use the host name, the IP 
address must be mapped to the hostname in the 
file /etc/hosts, or the workstation must have 
access to a Naming Information Service (yellow 
pages) server that maps the IP address to the 
host name. If there is no mapping, specify the IP 
address of the workstation.

<device_set> the name of a device set defined for the NDAM 
server without the NDAM prefix and the .dev 
extension. For example, if the file name is 
NDAM_eastern_region.dev, the name of the 
device set is eastern_region.

<process_name> is one of the processes identified in step 9
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